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Introducing  TimePorter
The ultimate travel companion for Apple Watch

TimePorter for Apple Watch sets the standard for how you carry your essential Watch 
accessories. This gorgeous leather-clad capsule is both a case and a stand that holds your 
charging cable, extra Watch band, USB charger and more in a neatly designed, silicone-lined 
case. Pop your charging disc into the integrated opening in TimePorter and drape Apple 
Watch across the top to charge. With your Apple Watch resting on TimePorter, open the case 
to the preferred angle and TimePorter transforms into a display stand, perfect for viewing 
notifications and the time. Available now in black and white leather finishes.
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Welcome

George Cairns
Did you know that you could work with RAW 
files in Photos? George shows you how, along 
with a whole host of tips and tricks, on page 
34. Essential reading for anyone with a DSLR. 

Roland Waddilove
Mac expert Roland has spent the last month 
researching the very best Automator scripts. 
Find out how you can automate daily tasks and 
save precious time over on page 52.

Freddie Harrison
Freddie has taken a tour of macOS Sierra to 
uncover everything Apple didn’t tell us at 
WWDC. This kicks off our huge 17-page cover 
feature on page 14. A must-read.

Meet the experts

“We’ve gone hands-on with the developer 
builds to rate every new feature”
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Operating systems are the glue that creates the 

relationship between user and machine. And when 

changes get made to those systems, that’s really big 

news in the world of Apple. WWDC, Apple’s annual 

developers conference, is dedicated to updating 

Apple’s software line-up, and this year we’ve been 

treated to four huge updates to macOS (note the 

name change), iOS, watchOS and tvOS. 

We’ve gone hands-on with the developer builds of 

them all to rate every new feature, reveal the hidden 

secrets and provide you with in-depth analysis. 

Dive into our 17-page cover feature this month and 

you’ll know everything there is to know by the time 

these new operating systems get their public 

release in September/October. We counted 125 

reasons to be excited by WWDC’s announcements – 

and we can’t wait to share them with you. Whichever 

Apple device you own, there’s plenty of content in this 

issue to make you enthusiastic for the rest of 2016. 

Philip Morris Editor



Contents... Visit the iCreate online shop at

for back issues, bookazines & DVDs

The only way to get all
your creative resources06 FileSilo

www.filesilo.co.uk/icreate

Tutorial files
This issue’s brilliant assets
Expert video guides
Walking you through new features
Stock video
Royalty-free clips for project use

4

14 125 reasons to be excited by Apple’s next generation

H H 
ma RA 



6

08 Trending
Teaching the next generation to code:
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recommend that you use a 
computer to download content, 
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accessing content on FileSilo 
take a look at the FAQs online 
or email our team at the 
address below.
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Why we’re really excited by Apple’s new Swift Playgrounds app
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#Trending

Teaching a new 
generation to code

By anyone’s standards, coding isn’t 
exactly easy to get acquainted with – 
and even more so for a child. That’s 
why Apple’s Swift Playgrounds 

app is a genuinely exciting idea that could soon 
usher in the next era of developers and coding 
enthusiasts. The app is a free download for 
the iPad and features an array of basic coding 
lessons and challenges. For children it offers the 
perfect mix of both fun and education, with an 
array of colourful characters on hand to guide 
them through their coding journey step by step. 
During the unveiling, an array of games and 
animations were showcased, all aimed at keeping 
budding coders raring to learn.

“I wish Swift Playgrounds was around when I 
was first learning to code,” said Craig Federighi, 
Apple’s senior vice president of Software 
Engineering. “Swift Playgrounds is the only app 
of its kind that is both easy enough for students 
and beginners, yet powerful enough to write 
real code. It’s an innovative way to bring real 
coding concepts to life and empower the next 
generation with the skills they need to express 
their creativity.”

Each lesson within Swift Playgrounds 
has been specifically designed to 
help children come to terms 
with core coding concepts, 
such as creating basic 
functions, performing 
loops and accounting 
for variables. Being 
able to simplify each lesson 
down to the basics is Apple’s 
way of hoping that the lessons will 
be able to build confidence and skill levels 
in children. Of course, Apple will also be hoping 

“Swift Playgrounds is both 
easy enough for students 

and beginners, yet powerful 
enough to write real code”
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Playgrounds, aimed at getting young coders to 
work together to resolve problems, increase their 
imagination and improve their skills.

“The new Swift Playgrounds app from Apple 
is one of the most powerful, yet approachable, 
educational coding apps we’ve ever seen, and 
we can’t wait to incorporate it into our upcoming 
camp curriculum,” said Jean MacDonald, founder 
of App Camp for Girls. “It’s a fun and intuitive way 
for our students to learn the basic principles of 

d, and also become skilled 
that can grow with them in 

e to do.”
der has built up a repertoire 
can then take what they’ve 
l. Swift Playgrounds provides 
ders to build their very own 

h that it can be then used 
rometer and Bluetooth 
Swift Playgrounds uses real 

and apps can be transferred 
n then be used to turn 
lly featured apps ready for 

ntion the benefits of using 
ygrounds. Its multi-touch 

display is perfect for the app’s coding keyboard, 
which gives access to the most commonly used 
coding symbols, with a shortcut bar also included 
that works in the same way as predictive text. 
You can also drag and drop a series of common 
coding symbols from a pre-built library by Apple, 
enabling users to speed up their projects and 
avoid the manual typing of symbols altogether. It’s 
of course optional, but Apple reckons it’s a great 
way for kids to experiment with their creations, 
without having to rely on long typing sessions to 
fix their mistakes. 

Simplicity is certainly key when it comes to 
developing for Swift Playgrounds, but at its 
very core, that’s what it’s all about. Getting 
kids enthusiastic and excited about coding is 
a tough task, but from what we’ve seen from 
Swift Playgrounds so far, it could be the winning 
formula needed to steer the new generation of 
coders in the right direction.

A preview release of Swift Playgrounds is 
available now to members of the Apple Developer 
Program in the iOS 10 developer preview. The 
final version of Swift Playgrounds is set for release 
on all iPad Air models, iPad Pro models and the 
iPad mini 2 later this year as a free download. 

Swift Playgrounds is 
colourful and engaging 
in order to inspire young 
budding coders



10

#Trending

Things we 
learned this 

month

Apple discontinues the 
Thunderbolt display
Apple’s Mac has undergone some major 
changes in the past few years, so much so 
that it has been confirmed that Apple will be 
discontinuing the five-year-old Thunderbolt 
display. This was announced in an interview 
with TechCrunch, but “it will still be available 
through Apple.com, Apple’s retail stores and 
Apple-authorised resellers while supplies last.” 

It’s widely believed that the core reason for 
the discontinuation of the display is due to 
the technology constraints it includes. With 

the new Mac sporting a 5K display, the 
additional Thunderbolt still features a lower 
2560 x 1440 resolution. The final nail in its 
coffin seems to be third-party, Thunderbolt-
styled displays that are dramatically 
undercutting Apple’s offering. 

Apple will still be selling the 27-inch 
Thunderbolt display through all official outlets 
with a price tag of £899/$999. You can also 
get your hands on refurbished models for a 
slightly cheaper price.

YouTube brings live
streaming to iOS YouTube

By finally integrating its live streaming 
feature into its iOS app, YouTube is 
enabling users to showcase themselves to 

potentially millions of people around the world. Live 
streams will work in the same vein as any other videos 
on YouTube, with users able to search for specific 
feeds, interact with comments and implement them 
into their own playlists. For streamers, analytic and 
metric information will be freely available, helping them 
co-ordinate all future content. YouTube live streaming 
is available now via a few updates in most markets.
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Apple Pay expands to
even more apps Apple Pay

Apple Pay has never been as popular 
as it is today, but the expansion just 
keeps on going. Some of the world’s 

biggest parking apps are now fully Apple Pay 
compatible, with the likes of PayByPhone Parking 
and Parking Panda enabling users to pay parking 
charges and avoid costly fines. Also on board is the 
popular Hotels Tonight app, which lets users make 
on-the-spot bookings without needing to enter and 
save their credit card details. Each of these apps 
are available for free from the App Store.

Watch will have micro-
LED display Apple Watch

Apple has filed for a patent, indicating the 
use of micro-LEDs in an upcoming Apple 
Watch, believed to be this year’s entry to 
the portfolio. There’s a variety of reasons 

why Apple is ditching the use of an OLED display in 
favour of micro-LEDs; the LED technology being able 
to produce a better colour gamut and finely tuned 
brightness levels. For end users, LED technology is 
considerably better for battery life, thanks to the lack 
of required backlighting. It’s not yet known who will 
be making the displays, though.

iOS 10 kernel arrives
unencrypted iOS 10

The kernel is responsible for core 
security issues and how apps interact 
with each other, but until now, the tech 
has been put under lock and key by 

Apple. However, the kernel in iOS 10 is to be the 
first left unencrypted – intentionally we should add. 
It’s believed that the move is to help Apple better 
optimise system performance on the iOS update, 
while it will also enable researchers to identify 
security flaws at a much quicker rate. The iOS 10 
update will be available later this year.
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1 Start browsing
Surfing the web in Safari on your iPad 
looks like this normally. To enable Private
mode, first tap on the overlapping boxes
again in the top-right corner.

1 Open Safari
From whatever page you’re on, tap 
on the two overlapping boxes icon in 
the bottom-right corner to view your 
open tabs.

1 Find Preferences menu
This trick requires a trip to Safari’s 
Preferences menu. Go to the Safari 
option in your main menu bar and click 
on Preferences, three options down.

2 Enter Private mode
This activates the tab viewer, but it also 
gives you extra options. For example, 
you can now tap Private in the top menu
bar to activate Private browsing. 

2 Find secret menu
If you tap the big plus icon at the bottom
you’ll open a new Safari tab, but if you 
hold it down and release you’ll see a list 
of Recently Closed Tabs.

2 Click to show
The option to ‘Show Develop menu in 
menu bar’ is hidden at the bottom of the
Advanced tab. Make sure you put a tick 
in the option’s box.

3 Read warning message
You’ll then be presented with this 
warning message, telling you that Safari 
won’t remember the pages you visit, 
search history or AutoFill details.

3 Restore tabs
It’s easy – just tap on one of your 
recently closed tabs and you’ll be 
redirected immediately to that active 
Safari tab.

3 Utilise Develop menu
The Develop menu automatically appears 
as a menu option in Safari’s menu bar. It 
opens a whole world of options for you 
to supercharge Safari.

Privacy is
important, and
that’s why there’s a 

Private browsing mode built 
into Safari no matter what 
device you’re using. 
Sometimes you just don’t 
want to leave a trace of your 
web history….

Safari houses some 
pretty advanced 
features within its 

Mac home, and some are 
hidden from view by default. 
For example, the Develop 
menu – basically a web 
developer’s toolkit – needs to 
be activated to be seen.

2  Activate Private 
browsing mode 

3  Enable the 
Develop menu

Closing a Safari tab
or window is easy –
swipe left with your 

finger or tap the ‘x’ in the top 
left of the tab view – and 
sometimes you’ll delete one 
by accident. Did you know 
you could quickly restore 
closed tabs?  

1  Restore recently 
closed tabs

What’s the one app that everyone uses virtually everyday? Well, there
are probably multiple ones, but Safari ranks pretty high. Originating in
OS X, Safari has grown into one of the world’s most popular desktop 
browsers and was the first multi-functioning mobile browser. It’s 
packed with features, with new ones added to every OS update, and 
a host of them are well hidden. Good job we’re on hand to show you a 
few neat little tricks for your iPhone, iPad and Mac.

MINUTE PROJECTS
TO TRY TODAY

3

1 2



Incredible Creative Tools

Whether you need to pull a key, track objects, retouch images, animate titles, 

or create amazing 3D particle effects, Fusion has the creative tools you need! 

You get a true 3D workspace, the ability to import 3D models and scenes 

from software like Maya and 3ds Max, along with hundreds of tools for 

compositing, paint, animation and more!

Scaleable Studio Power

Fusion’s GPU acceleration gives instant feedback while you work, so you 

spend more time being creative and less time waiting! Fusion 8 Studio also 

includes optical flow and stereoscopic 3D tools, along with unlimited free 

network rendering and tools to manage multi user workflows, track assets, 

assign tasks, review and approve shots, and more!

For over 25 years Fusion has been used to create visual effects on 

thousands of blockbuster films, TV shows and commercials. Fusion features 

an easy to use and powerful node based interface, a massive tool set, true 

3D workspace and GPU accelerated performance all in a single application! 

Now with Fusion 8 you can use the same powerful software to create your 

own blockbuster effects!

Hollywood’s Secret Weapon

Fusion has been used to create groundbreaking visual effects and motion 

graphics for Hollywood films such as The Martian, Thor and The Hunger 

Games, as well as on hit television shows like Orphan Black, Breaking Bad, 

Grimm and Battlestar Galactica! If you’ve ever gone to the movies or 

watched television, then you’ve seen Fusion in action!  

Work Faster with Nodes

Fusion uses nodes to represent effects and filters that can be connected 

together to easily build up larger and more sophisticated visual effects! 

Nodes are organized like a flow chart so you can easily visualize complex 

scenes. Clicking on a node lets you quickly make adjustments, without 

having to hunt through layers on a timeline! www.blackmagicdesign.com/uk

For Mac OS X and Windows 

For Mac OS X and Windows 

FUSION  .................................................................................................Free Download

FUSION  STUDIO ................................................................................................£735*

NEW FUSION 8
The world’s most advanced visual eff ects and motion graphics software!

*SRP is Exclusive of VAT. 
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WDC is just about our favourite 
time of the year. It’s the annual 
keynote dedicated to software, 
and it maps out Apple’s plans for 

its next generation of main operating systems. 
It’s the showcase for all the latest and greatest 
features, and 2016 has got us really excited. 
We’ve put our experts to the test and gone 
hands-on with the developer betas, delving deep 
into every new operating system to uncover 125 
reasons why we’re super excited. 

Take macOS Sierra, for example. The change in 
moniker might be headline news, but that doesn’t 
even scratch the surface. Siri has come to the 
Mac at last, and gives you a digital personal 
assistant to help you with the things you do every 

day. Then there’s new features added to Photos, 
and Apple Pay added to Safari. You can now 
unlock your Mac with an Apple Watch on your 
wrist, and copy and paste between Mac and 
iOS device. Genius. iCloud Drive is better than 
ever too, and gives you access to your desktop 
on any device logged in to your iCloud account 
– even an iPhone or iPad. Optimized Storage is 
going to save a huge amount of space too. It’s all 
happening on the Mac.

We’re not marginalising iOS 10 either, because 
that is quite possibly Apple’s biggest ever mobile 
update. Don’t believe us? You better turn the 
page and get reading. Throw in some great new 
features to watchOS and tvOS and we can assure 
you, this is great time to be an iCreate reader.

Apple’s Beta Software Program
You don’t need to be a developer to get access to Apple’s new software before it is officially 
released in the autumn. Apple’s public beta program for macOS Sierra and iOS 10 will be 
open to anyone with an Apple ID and compatible device from beta.apple.com.

15

Apple releases public betas to allow members of the public to test-drive pre-



macOS Sierra finally 
welcomes Siri to the Mac
Your Mac has a new digital personal assistant and she’s very clever

Siri on the Mac was much rumoured and even leaked 
prior to the announcement of macOS Sierra at 
WWDC. That doesn’t mean it’s not worth getting 

excited over, though. On iOS, Siri has become significantly 
faster over the last few years and seems to be more and more 

capable of deciphering complex verbal requests. Some might 
say that Siri on the Mac was a long time coming, but in many 
ways, iOS was its training ground.

Launching Siri is easy; click on its new dock icon, hit the 
menu bar icon or tap Function+Space to get going. 

Siri looks set to become the
fastest way to find files on

your Mac. Asking things like
“Show me PDFs I
opened last week”

will quickly help you to
sort through all of
those documents.

One of the coolest parts of Siri
on the Mac is that results can
be dragged onto the desktop
and shared. We expect plenty
of requests like “Search

the internet for
pictures of
funny cats”.

There are plenty of Mac-
specific Siri requests you 

can make, but don’t forget 
about the classics. Asking, 

“What’s the weather 
like in London?” will 

quickly give you the latest 
forecast in the capital.

Siri isn’t just about searching. 
Interaction with apps is also 
possible too. For example, 
asking Siri to “Add a 

calendar event at 
10am tomorrow”, 
should do just that in the 

Calendar app.

With iCloud Optimized 
Storage working its magic, 

asking Siri “How much 
space is left on my 

Mac?” might seem a 
little silly, but it’s still nice to 

know exactly how much 
has been saved.

If you’ve got an Apple Music 
subscription, you can let 

Siri play DJ. Say things like 
“Play some Eighties 
tunes” or “Play me 
some jazz” and you’ll 

soon be streaming the 
songs you want.

Pin your results
As you ask Siri questions, the
answers you get can be pinned
and saved as Notification Center
widgets. They’ll stay up to date too,
so your most frequently requested
information can be accessed even
quicker. Just click the plus icon in
the top-right corner of any results
pane to pin it.

Apple’s next generation
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Store your desktop in iCloud Drive
Move closer to having every Mac in perfect sync

What’s new in 
Messages?

With Messages
running across both 
macOS and iOS, it 

makes sense that Apple has 
rolled out similar upgrades to 
both. While they’re mostly there 
to make Messages more fun, a 
few of these improvements 
have made it more useful too. 
Now on your Mac you’ll be able 
to respond to the messages 
you’ve received using the new 
Tapback feature — giving an 
instant reaction to what you’ve 
just been sent while you work 
on a response filled with all-
new larger emojis. On the more 
practical side, sending links to 
a website will show bigger, rich 
previews of their content.

Unlock your Mac 
with Apple Watch

Entering a password 
has become a thing 

of the past

If you’re lucky enough to be wearing 
an Apple Watch while you work away 
on your MacBook Pro (or any other 
Mac running macOS Sierra, for that 
matter), you can forget about entering 
your password to access your desktop. 
Now, as long as your Watch is unlocked 
and within three metres of your Mac, 
you’ll bypass the password screen 
on macOS and unlock it for use 
automatically. All you need to do is 
be sure that both devices are on the 
same iCloud account, so that they can 
recognise each other over Wi-Fi and 
Bluetooth to make the connection.

 Not just desktop
The macOS Sierra iCloud sync features 
aren’t just limited to the Desktop folder. 
Your Documents folder is covered too, 
making the whole thing even more useful 
for syncing up multiple Macs.

 Check your storage
To take full advantage of desktop and 
documents iCloud syncing, you’ll need to 
ensure your iCloud account has adequate 
space — the good news is that it’s a 
relatively cheap upgrade.

 Sync or swim
In macOS Sierra, iCloud Drive now syncs 
your Mac’s Desktop folder, meaning 
anything you store there will be accessible 
on your iPhone, iPad or other Macs that 
you are using.

 Use the app
To access your Mac’s desktop on your 
iOS devices, you’ll need to fire up the 
iCloud Drive app. There you should see 
your Desktop folder and its associate 
files inside.

Taking the lead from 
iOS 10, Messages 
becomes more fun
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To unlock your Mac with Apple Watch, you’ll also need to have watchOS 3.0 
installed and running on your wrist — it’s worth updating for this alone!



Photos gets updated
Your favourite image editing app gets a lot of love

Copy & paste between devices
Revolutionise how you work across your devices
Universal Clipboard feels like a long time coming, and many third-party apps have 
attempted to make it a reality. But with macOS Sierra and iOS 10, copying and 
pasting from your iPhone or iPad to your Mac or vice versa is now possible. Your 
devices will need to be signed in to the same iCloud account, and data is transferred 
via Bluetooth and Wi-Fi to ensure your information remains secure at all times.

Find people
Under the Albums tab, you’ll see
a new People album. Not only
does Photos recognise objects,
but it recognises faces and
groups photos of people into
their own albums.

 Even smarter searches
Photos can now recognise 
objects and even whole 
landscapes inside images, 
so you can search for photos 
including your dogs, ice creams 
or just about anything else you 
can think of.

 Resurfacing 
your Memories
Under the new Memories tab, 
you’ll find a set of albums that 
Photos has curated itself. The 
idea here is that you’ll find 
older memories of specific 
places or events.

On the map
Much like the People album,
Photos in macOS Sierra borrows
a lot from its predecessor —
iPhoto — so there’s a new Places
album that puts your photos on a
map too.

 Smart place searches
By recognising landscapes 
like beaches in your images, 
Photos will enable you to search 
by specific locations – ‘Venice 
Beach’ for example – as it can 
match the two together.

Even easier editing
Photos’ editing tools have also 
been given some love in macOS 
Sierra. A new Brilliance tool 
helps to improve highlights, 
contrast and emphasise details 
in a single click.

On-device AI
Apple is boosting its privacy
credentials with macOS Sierra by
doing all of Photos’ in-image object
recognition on your device, so your
photos are kept private and not sent
to a server for processing. It’s an
impressive feat and sets Apple
apart from its competitors as far
as privacy goes.

Apple’s next generation
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Photos Movies Mail Apps System Audio Backups

Save space on your Mac
with Optimized Storage
Optimized Storage makes Macs with small SSDs even better

Six new Mac 
features to 
be excited by

If you already use Apple Pay to complete transactions in
iOS apps, you’ll know how convenient it can be. Apple
has now opened up Apple Pay to web developers so

they can implement Apple Pay into their online stores. Practically, this
will work when you’re browsing in Safari and you’ll need your iPhone or
Apple Watch to authenticate the payments. Buying online might be a
whole lot easier as a result, but this ensures it’s still secure too.

Shopping online is now safer and easier
Use Apple Pay in Safari

iCloud Photo Library has already saved a lot 
of headaches when it comes to managing the
masses of images on smaller iPhones, but

with macOS Sierra Apple is expanding this technology
across the Mac. iCloud Optimized Storage will move
older files and anything that might be unnecessary to

keep locally (for example, ebooks that have been read) 
to iCloud to free up space on your Mac. You’ll still
be able to access these files with ease, but your
Mac’s local storage will have a little more room as a
result. For anyone with a small SSD, this will certainly
prove invaluable.

What files are moved, deleted or optimised?

Picture-in-picture
Now you’ll be able to play 
videos from Safari or 
iTunes in a picture-in-

picture-style setup as you work 
elsewhere on your Mac.

Tabs across apps
Thanks to Safari, tabs 
have become the tool for 
multitaskers. With macOS 

Sierra, you can now use them in 
apps like Pages and Maps too.

Safari extensions moved
Safari extensions have 
been getting less and 
less love from Apple. 

They’ll now be in the Mac App 
Store with a new lease of life.

Safari disables Flash
By default, Safari will now 
disable Flash. In most 
cases, HTML5 content 

will take over, but you can enable 
it in a click.

RAID support is back
Sierra once again makes 
it easy to create RAID 
arrays out of drives using 

Disk Utility, without delving into 
the complexities of Terminal.

Gatekeeper upgraded
Gatekeeper’s options have 
been reduced in macOS 
Sierra to no longer 

automatically allow apps from 
untrusted developers to open.

Full-resolution photos
If iCloud Photo Library isn’t already 
enabled on your Mac, macOS Sierra 
will prompt you to switch it on

Older documents
Any older documents or files that 
haven’t been recently used (such as 
presentations or image and text files) 
will be uploaded to iCloud

Unused MAS apps
Apps that you’ve downloaded from 
the Mac App Store but haven’t been 
used will be removed locally and 
re-downloaded when needed

System files
System files such as IPSW files from 
iTunes, cached Maps data, Apple 
Music caches and other logs will be 
automatically deleted

Mail attachments
Although emails themselves take up very little 
room, their attachments can add up. iCloud 
Optimized Storage will sweep these up

iOS device backups
It’s rare that your Mac will feature too many 
iOS device backups now iCloud is around, 
but any old ones will be deleted

Documents
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Messages will 
transform texting
iOS’s Messages app gets a huge overhaul

Animated
backgrounds
Animations can now
be displayed over the
entire Messages screen, 
perfect for when you
want to congratulate
someone or display
extra emotion. The
effect is truly brilliant.

Emojification
Emojis now dominate 
the iMessage 
experience with a raft 
of new features, and 
you can now even tap 
words in a message 
you have written to 
automatically replace 
them with emojis.

Stickers
You will now have 
the ability to place 
stickers on top of 
messages in order

d some extra
to a photo 

We 
ent 
e.

Edit photos
Photos can now
be edited within the
Messages app itself,
and you can also
annotate them if you
need to point out a
specific area.
Videos can even be
annotated too.

Bubble effects
Your message bubbles 
can take different forms 
depending on how you 
want the message to 
come across. You 
can whisper and show 
the text in a smaller 
form or shout loud for 
greater emphasis.

No Slide to Unlock
The legendary Slide to Unlock feature 
has been removed so that you can 
access the widgets from the home 
screen and also the camera if you swipe 
left. With Touch ID used to access your 
device securely, it makes sense for the 
lock screen to now offer much more 
functionality rather than merely being a 
barrier to useability.

Widgets
side panel
Slide to the right from
the new lock screen
and your widgets will
be displayed. This
not only makes them
quicker to access,
but the widgets
for the stock apps
now display more
information. There
is a selection of new
ones to try out too.

Raise to Wake
This new feature is 
a simple innovation, 
but one that offers 
a few advantages. 
You will now be 
able to view the 
lock screen without 
accidentally jumping 
past it, and because 
it now displays more 
information, you may 
not need to even 
access any apps.
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Widgets and options
3D Touching many apps will 
now display options and a 
widget meaning that you 
may not need to even 
open the app. Very quick 
and convenient.

Share an app
If you 3D Touch any app a 
new Share option will now 
appear, which lets you send 
an App Store link to friends 
and family.

Rename folders 
Folders can be renamed 
by simply 3D Touching and 
then selecting the Rename 
option that appears.

Jump to apps
When you see the red 
notification icon on a folder, 
3D Touch to jump straight 
to the app in question.

Flashlight intensity
3D Touch the flashlight icon 
in the Control Center to 
change the brightness 
of the flash.

Clear all notifications
You can now clear all 
notifications by 3D 
Touching on the ‘x’ and 
then tapping the pop-up 
option that appears.

New 3D 
Touch 
capabilities

Handwritten 
messages
You can now write 
a message in your 
own handwriting 
and it will be 
displayed in an 
animated form, in 
exactly the same way 
you wrote it.

Tapback 
replies
With just one tap 
you can now send 
one of six quick 
responses if you 
are in a hurry. The 
responses are 
intelligent enough to 
cover most situations.

Dedicated 
App Store
Developers are now 
able to create solutions 
that can be used with 
iMessages. Examples 
include stickers and 
GIFs, collaborative 
reservations and even 
sending payments.

Digital Touch
Making its way 
over from the Apple 
Watch, Digital Touch 
will now work on 
all devices. You 
will be able to send 
heartbeats, sketches 
and much more 
within a message.

Built-in Camera tool
Previously, if you wanted to snap a new picture and send it to 
someone via Messages, you needed to head out of the app, open 
Camera, take the shot, then head back to Messages and attach it 
that way. iOS 10 will save you loads of time, by giving you the ability 
to shoot a new picture without leavin Messages. Hooray!

A new Notification Center
A Spotlight search bar is now included 
at the top – it’s certainly useful to 
have it available in as many places as 
possible! Besides the new look, the 
rest of the Notification Center will feel 
familiar, so will remain as beneficial as 
it always has been.

Richer notifications
In many cases, you will not need 
to leave the lock screen at all when 
viewing photos and videos or 
responding to messages. From a 
notification, Force Touch on it and see 
your options to reply, without opening 
its parent app. 

App animations
When you open apps in 
iOS 10, you’ll notice subtle 
differences. They feel 
springier, but take slightly 
longer to open than before.

Control Centers
You can now swipe left 
in the Control Center to 
access an audio playback 
pane, and right to control 
your smart devices.

Redesigned CC 
Choosing a function in 
the Control Center is now 
much easier with its larger 
design. The top row is 
also more colourful.

Developer-updated 
notifications
Developers are now able to 
check the information that 
is presented in notifications 
and update them instantly.

A new design
The lock screen and 
notifications have 
undergone a revamp so 
that the background no 
longer dims. 
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Rediscover your most 
cherished photos
The Photos app in iOS 10 has been improved everywhere 

The headline features offer a
lot to look forward to, but
historically it is always a

combination of features that make for
a brilliant experience. The list of
improvements is so long that we
couldn’t possibly cover them all, so
here we highlight some of the best.

Essential iOS 10 upgrades
Safari Apple Pay

Apple Pay’s reach is 
about to grow thanks to 
Safari integration. You will 

be able to make a purchase on a 
Mac and use your iPhone to 
authenticate the payment 
instantly. Now that’s clever!

Deal with spam
The Phone app in iOS 10 
will now try to gauge if an 
incoming call is spam. No 

system can guarantee to catch 
every call, but with mobile spam 
so commonplace, this is a 
carefully considered improvement.

Collaborative notes
Notes was recently 
updated to make it much 
more flexible, but the 

addition of collaboration in iOS 
10 means that you will be able to 
work on a note at the same time 
as others.

 Object 
recognition
As you take photos 
objects will be 
recognised, so that 
when you search 
for an object, the 
related photos 
will be sent back 
as results.

Facial
recognition
The app can
recognise faces
and collate photos
of the individual
through different
ages. This is then
used to keep your
photos organised.

Memories
Photos will be
aggregated based
on location,
date and image
recognition to
automatically create
special memories.
Video montages can
also be created.

 Adjust 
brilliance
There is a new 
Brilliance adjustment 
slider, offering more 
intelligence behind 
the scenes so that 
you can improve 
your photos with 
even less effort.

Better auto enhancement
Another feature that has been tweaked 
is the auto enhancement, which is more 
refined and is thus able to markedly help 
you to add more depth to your photos.

People albums
Albums can be created based on the facial
recognition that the Photos app offers.
The process is automated, so there is no
management needed from your side.

You can finally delete stock apps
You can remove stock apps in iOS 10, but the process 
actually only removes the icons so as to preserve the 
main operating system. User data will also be removed, 
but the main advantage is that you are now able to 
declutter your home screen. Remember that certain 
functions in Siri and the like will no longer work, so you 
should carefully consider the apps you are removing. 

All-new QuickType keyboard
The iOS keyboard has improved in small steps over the 
years, but the new QuickType keyboard is a genuine leap 
forward. Contextual awareness is built in so that you can 
respond to messages more efficiently, and intelligent 
scheduling lets you easily switch between languages. Add 
to this some clever Siri-assisted keyboard features and 
your data entry is about to improve beyond recognition.

New Search abilities
Because Photos has new deep learning algorithms, 
searching your library for specific things is easier than 
ever in iOS 10. As such, Photos will be able to scan for 
people, animals, places, objects and more. It will even 
categorise entries to help you find what you want.
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Siri is open to third-
Siri is about to become more 
flexible than ever before

There is a new 
Home app in iOS 10 
which lets you 

control any smart devices 
that are connected to your 
phone or tablet. It will cover 
rooms so that you can 
change settings with a couple 
of taps, and scenes can also 
be set up for each individual 
space. Even better, the 
automation section will work 
based on times and 
locations, and an Apple TV
can be used as a remote hub
to increase flexibility even
further. The fact that many
often-used settings are
available with a swipe from
the Control Center is an
added bonus.

Home 
automation 
made easy
A new way to 
control your 
smart devices 

Starting workouts, which can 
be cumbersome, will be 

supported by Siri and should 
come to the Apple Watch as well. 

For example, say “Start a 
run with Strava” 

and you’re done.

You may want to use third-party 
calling apps to call people, and 
it’s now possible using just Siri. 
For example, say “Call Phil 
using WhatsApp” and it 

will work perfectly.

You could say “Get me an 
Uber to Fleet Street” 
and Siri will command the Uber 
app to book a ride for you. No 

taps on the screen, just a 
simple question. 

The ability to search for photos 
in third-party apps means that 
you can view any photo on any 
service and even, for example, 

start a slideshow in Google 
Photos from Siri.

Depending on the services and 
money management apps you 

have installed, you will be able to 
easily send money to people by 
simply saying the amount, app 

and contact name.

Messages can be sent using 
third-party apps meaning you 

can simply say “WhatsApp 
John and advise that 
I will be an hour late 
to the meeting” without 
the app needing to be opened.

Optimise storage
If you are running out of 
storage, iOS 10 can 
automatically remove 

songs to free up some space. 
The clever bit, however, is that it 
will only delete songs you have 
not played in a while.

Game Center lives?
The Game Center app has 
been removed and will be 
replaced by GameKit. The 

platform will still work though with 
new invites being handled through 
messages. This is another way to 
reduce clutter in the home screen.

iCloud Mac desktops
Improvements in iCloud 
Drive mean that you will 
now be able to share 

documents to other Macs, 
iPhones and iPads. Most of the 
manual transfer work will be 
gone forever.
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Apple Music has
been completely
overhauled

Read breaking news
in Apple’s redesigned
News app

Every Apple Music
improvement you wished
for has been implemented

Subtle and highly useful
additions come to Mail Now you’ll never miss an important story

It would be fair to say that
Apple Music received
mixed reviews when it

was first released, for a number of
different reasons. The main
complaint was the cluttered and
complicated interface, but in iOS 10
Apple has made efforts to ensure
that the UI is easy to understand
and use. Extra features have been
added in a conservative fashion as
well, in order to create a solution
that feels much more like an Apple
creation than previously.

The Apple News app now features a cleaner
design that is designed to ensure the content
dominates the interface. The For You section has

been tidied up with more topics alongside trending news
and the most popular stories, many of which are hand-
picked by Apple’s editors. Also, breaking news will now
appear as notifications so that you do not miss any
important events that would have previously resided in the
app and nowhere else. These simple changes make a big
difference to how well the app works and how visually
effective it is in iOS 10.

What’s new
in Mail?

Threaded conversations in Mail will
now display messages in a single
pane for ease of viewing. These

threads can be displayed in oldest or newest
order or can be turned off completely. On
the 12.9-inch iPad, a three-column view is
used just like on laptops, and there are
various other small tweaks that will save you
time over and over again. Newsletters will be
accompanied by an Unsubscribe button at
the top of each message and more
advanced filters are available to help deal
with busy mailboxes.

1
The UI has been overhauled with 
an emphasis on making it visually 
cleaner and easier to use. Many 
features have also been simplified 

for added efficiency.

2
3D Touch features will allow the 
sharing of songs and albums, 
and are particularly useful for 
previewing new music. It helps to 

ease the previously cluttered interface.

3
A new section called Browse has 
been added to bring together 
charts, curated playlists and 
featured music launches. This 

should make each feature more obvious 
when in use.

4
The Connect section has been 
removed, but the functionality will 
continue with new posts showing 
up in the For You section. The 

emphasis is on your preferred music now.

5
When content is playing you can 
scroll up in the album art to see 
the lyrics where supported. This 
is a feature that adds depth to the 

music-playing experience.

6
Downloaded music is now 
displayed in a more obvious 
fashion, meaning that you can 
clearly see what tracks you own or 

have downloaded through Apple Music.

Apple’s next generation
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The bits Apple didn’t tell you

Using Maps 
has never 

been easier
Maps becomes even 
more useful and a lot 
more intelligent

Unlimited
Safari tabs

An unlimited 
number of 
tabs can now 

be opened in Safari, 
offering many 
benefits. Thanks to 
the way it works, you 
should not run out of 
memory while 
opening them either.

Integrated
VoIP apps

VoIP apps 
can now work 
like the 

Phone app and will 
behave in the same 
way standard phone 
calls do. This should 
quickly open the 
market for alternative 
calling plans.

Voicemail
transcriptions

In iOS 10, you 
will be able to 
read 

transcriptions of your 
voicemail messages, 
which should save 
you from having to 
open each message. 
This is certainly a 
huge time-saver.

Bedtime Alarm
The new
Bedtime
Alarm

function is designed
to ensure that your
sleep times are
consistent, by
reminding you when
exactly to go to sleep
as well as when to
wake up.

Dark Mode
This mode
has been
found in beta

versions of iOS 10
and is not yet official,
but it promises to
potentially reduce eye
strain and give
another option in
poor lighting
conditions.

Split View Safari
If your iPad
supports
Split View

multitasking, you
can now conveniently
work with two Safari
windows side by
side. This also
applies to the Mail
app for composing
messages.

Automated navigation
One of the main benefits of Maps in iOS 10
is the ability for the app to proactively do
more than one thing at once. For example, if
you open the app when you normally leave
for work, it will show you the route and also
highlight any traffic problems.

A great combo
Siri and Maps will now work together to 
offer proactive routes based on calendar 
events, time and location. These can 
cover commutes and one-off trips.

A new look
Maps has been tweaked visually so that 
routes and locations are more obvious, 
and the instructional feedback is now 
more timely and easier to understand.

Map extensions
Developers can integrate their apps into 
Maps with new extensions. You will be 
able to call an Uber, book dinner and do 
much more without leaving the app.

Automatic parking
Maps knows when you park and will pop 
up a notification so that you can head 
straight back to your car, no matter how 
large and confusing the car park is.

Deal with traffic
Traffic conditions are displayed en route
and a new dynamic view makes looking
ahead easier than ever. This means less
time not looking at the road ahead.

Detour for food
You can now quickly search for food
stops, fuel and drinks from within Maps.
This is particularly useful if you have an
urgent need to take a detour.

The ability to automatically stabilise Live Photos is expected in iOS 10, which 
should greatly improve the way they look when opened in Photos.
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Apple Watch
is now seven
times faster

Here’s how
performance and
navigation have

been vastly improved

Enjoy new
Watch faces

Reach your 
Dock via the 
side buttonGlances view

replaced
by Control
Center

Time for something
new? There are
three fresh designs

Instantly go to your favourite 
and most recent apps

nie Mouse
Minnie Mouse is a fine
o Mickey, who debuted

al watchOS. She comes
t colour outfits that will
shade of your band.

A watch wouldn’t be a watch
if it didn’t tell the time, and the
beauty of Apple’s device is that
you needn’t get bored staring at
the same old face. With watchOS
3, you can make use of three
extra designs, each of which are
customisable so that you can add
the complications, colours and
layouts that best suit you.

The side button was once largely 
wasted on the Friends carousel but 
watchOS 3 assigns it to a new Dock. 
Immediately accessible via a single 
press regardless of what you’re doing, 
it shows the apps you have been using 
and those you wish to retain for future 
navigation. Adding apps is easy – select 
one from the app carousel, tap Side 
and select Keep In Dock. You can retain 
up to ten apps in the Dock and remove 
them by swipin d
tapping Remov

It used to be that swiping up from
the bottom on the watch face
displayed the Glances view, but
soon you will see a Control Center
for your most used settings. Aside
from Do Not Disturb and Airplane
Mode functionality, you’ll be able to
see your battery percentage, enter
a Power Reserve mode, ping your
iPhone and select AirPlay too.

Change face by 
swiping left or right
If you want to change the 

watch face, you’ll be able to 
simply swipe left and right 
from the edge of the Watch 
screen, rather than Force 
Touching first and tapping 
the one you want as you 

have to do at present.

Complications can 
now be added to 

plain faces
Complications will be 

soon be available for the 
Extra Large face as well 
as Photo, Timelapse and 
Motion, which means you 
don’t have to compromise 

on a style you like.

Set up faces in 
Apple Watch app
A Face Gallery is being 

added to the Apple Watch 
app on the iPhone, which 
will let you use the larger 
screen in order to alter 
watch face colours and 

Favourite apps 
launch instantly

Having apps in the dock 
serve an extra purpose: 
they enable you to load 
them seven times faster. 
The Watch retains those 
apps in its memory and 

ting them.

Activity
Popping to the gym or looking to 

jog around the park? Choosing the 
Activity face lets you see your daily 

activity rings. It works with analogue 
and digital clocks or chronograph.

Numerals
This is perhaps the cleanest and most 

elegant of all the watch faces. Fully 
customisable, it displays a single 

number for the current hour together 
with the clock hands.

Apple’s next generation
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Crucial features
to Watch out for

With watchOS 3 your device is getting a major face-lift

Home
One of the most 

exciting additions 
to iOS 10 was the 

Home app that lets 
you control HomeKit-

connected accessories, 
so having a watchOS-

equivalent for quick 
access is welcome.

utton
ds to
ncy
r
r

Wi-Fi.
gency
here is

Camera zoom
When you are in 

the camera app on 
your Apple Watch, you 

will be able to use 
the Digital Crown to 

zoom in and out 
when sizing up 

that perfect remote 
shot on your iPhone.

rs
on’t be
ks from
nders

will
r the

ed on
your

them

Messages
This app is not being 

left behind by the 
refresh it is getting on 

iOS 10. It’ll be easier to 
reply to a message and 

you’ll be able to 
use your finger to 

hand write responses 
and use stickers.

y
work in
the iOS
tomatic
dating,

trace
enever

Find My Apple Watch
You’ve been able to 

locate your iPad and 
your iPhone, but with 

watchOS 3 you will be 
able to discover the 

whereabouts of your 
Apple Watch through 
the iOS app as well.

te
f the

nce

new
It

s as
n, of
ed to

the Dock.

Disable screenshots in
Apple Watch app
When you press the side button and the Digital
Crown together, you can take a screenshot that
is saved to your iPhone’s Camera Roll. If you
don’t want this functionality you can’t currently
deactivate it, but with watchOS 3 you’d go to
the Watch app, look for Enable Screenshots
and select Off.

When you walk up to your Mac with your Watch strapped to your wrist, the 
computer will automatically unlock giving you instant, password-less access.
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There’s definitely no need for a separate fitness band

Why fitness and wellbeing
remain top of Apple’s
smartwatch priority list

Share your
Activity stats
for motivation

There is nothing more
motivating that getting
into a competition with
someone, and that’s

especially true when trying to keep
fit and stay healthy. With watchOS
3, you will be able to enjoy a new
feature called Activity Sharing by
simply swiping to the right of your
Activity rings and calling up the
rings of your family and friends. This
lets you compare how each other is
getting on and hopefully prompt you
to try that little bit harder, and it lets
you send motivational messages too
– the built-in replies are tailored for
that very purpose.

Optimised
Activity app for
wheelchairs

We love this new addition for 
wheelchair users. It is being 
tested on wheelchair-using 
employees at Apple and 

brings with it two wheelchair-specific 
workouts, as well as a ‘Time to roll’ 
reminder that replaces the ‘Time to stand’ 
prompt. It has been produced in 
conjunction with the Lakeshore Foundation 
and the Challenged Athletes Foundation 
and has some neat functions, such as 
allowing each push of the wheel to count 
towards a calorie goal just as a step would 
for able-bodied people.

Brand-new 
Breathe app for 
relaxation

A healthy 
lifestyle isn’t 
just about being 
on the go all 
the time. It is 

also important to take a 
breather and relax – and 
that’s where this new app 
comes in. It seeks to help 
you manage your stress by 
using an on-screen graphic 
or haptic taps to lead you 
through deep breathing 
techniques. The sessions 
last for just a minute by 
default, during which you 
are guided through seven 
breaths. You can increase 
the time and slow the 
breaths if you’re feeling 
particularly on edge.

More improved
Workout metrics

Even though the
Watch screen is
tiny, that
doesn’t mean
you can’t pack a

lot of information onto it.
For those who enjoy using
the device during a workout,
it will be possible to see
five metrics displayed at
any one time: distance,
pace, active calories, heart
rate and elapsed time. You
will be able to highlight
which of these are most
important to you, so that it
is more prominent during
your workout.

Apple’s next generation
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Complete third-party
controller support

Talking to your TV 
made easy in tvOS 10

Play tvOS games without the Remote

The Siri Remote is about to become really powerful.
Here’s a rundown of the new things you can ask

One of the biggest bugbears for tvOS games 
developers was Apple’s insistence that they had 
to make their titles work with the Siri Remote. 

Not any more. To the delight of gamers everywhere, tvOS 10 can 
ditch the remote and insist games are played with a third-
party made-for-iPhone/iPad/iPod (MFi) controller 
instead. This move could position Apple TV as a viable 
and attractive games console in its own right.

Apple appears to be opening itself up more and more.
With tvOS 10, developers are able to enjoy three APIs
when creating for Apple TV: ReplayKit, PhotoKit and
HomeKit. The latter is perhaps most familiar to you
– it will let you control home-based devices such as
connected security cameras from the comfort of your
sofa. ReplayKit enables developers to make use of live
gameplay footage whether for streaming or to show
how you fared. PhotoKit will allow third-party apps
access to photos and videos stored in iCloud.

Developers have
greater access
Expect more third-party apps
with core functionality

Siri will be able to 
handle multiple search 

criteria, so you’ll be able 
to say “Show me 

superhero movies 
from the Nineties” 

and it will call on its 
knowledge of movie genres.

Apple TV is not following 
in the footsteps of iOS 10 
and watchOS in offering a 
Home app, but you will be 
able to use Siri to control 

HomeKit-compatible 
devices such as lights 

and thermostats.

Fancy watching a 
documentary on a specific 
topic? Siri has your back 

there too. Say “Find 
documentaries about 
the Tudors”, for instance, 

and it will quickly deliver 
some historical visual treats.

Siri supports more
third-party apps including
YouTube. It means you can
utter the words “Search

YouTube for” and tell Siri
exactly what you’re after, and
it will open the app and find

results for you.

Since tvOS 10 is
introducing a feature called
Live Tune In that hooks into
live programming streams,
you could ask “Watch

ESPN”. This would open
up the live channel in

an instant.

A new Apple TV Remote
app with Siri integration
is in the works, so if you
prefer to use your iPhone

to control tvOS you’ll
still be able to use the
power of your voice in

order to do so.

Dark mode
Dark mode is not quite a killer feature, but if you’ve found the
tvOS interface too bright, there is now a way to fix that. By
switching the light background of tvOS to one that is much
darker, this mode provides greater contrast and will work
particularly well in dimly lit home cinemas.

in Photos will prove useful in grouping pictures to create slideshows.
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Authenticate paid services 
once and never again
Single Sign-on will revolutionise how you enter passwords 
There are lots of television apps on Apple TV and 
having to sign in for each one is painful. With tvOS 
10, all that is changing – for customers in the United 
States at any rate. A single sign-in is all that will 

be required for American cable 
ustomers, and that means no 
ore usernames and passwords 

for accessing individual pay-TV apps such as HBO GO 
and FXNOW. As long as the developer incorporates 
the feature, the sign-in process will display a page 
showing the apps that will be authenticated all at 
once. This is less of an issue with television viewers 
in the UK, especially given that the key providers Sky 
and Virgin aren’t yet on the platform.

While the Siri Remote is a
well-designed, intuitive
zapper it still doesn’t

mat
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Remote app
for iPhone
Use your iPhone
as an alternative to
the physical remote

New aerial
screensavers
The number of those
gorgeous day and
night aerial HD videos,
which currently feature
beautiful shots of
Hawaii, London, New
York, San Francisco and
the Great Wall of China,
are about to be boosted
with a fair few more.

Support for
app badges
App badges are the little
red blobs containing
numbers that appear
on icons when there
are messages or
notifications to deal
with. Up to now they
have been confined to
iOS and Mac, but they’re
coming to tvOS soon.

Continuity
keyboard
The new continuity
keyboard will make life
easier when inputting
text. It will kick into
action on your iPhone
whenever the Apple TV
requires it. It will sure
beat using the Remote
to shift a cursor around
an on-screen keyboard.

Apple’s next generation
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Soft Boxes
Reflector and Diffusion Panel

Reflectors
Shapeable with Multiple Uses

Flash Grids & Gels 
Universal Designs Attach Quickly
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Available to purchase from leading photography retailers
www.calphoto.co.uk    www.wexphotographic.com

Rogue offers a range of innovative lighting accessories 

that allow photographers to direct and shape light, giving 

them greater control. The lightweight products are ideal 

for location photographers. They are strong, durable and 

can be flat packed for easy storage or transportation.

Portable lighting tools for photography professionals and enthusiasts

Santa Cruz, California

®

ROGUE® Safari  
Pop-up Flash Booster
Uses light from your DSLR  
camera’s pop-up flash
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Photos

You’re missing out if you have never used the Levels tool in
your Mac’s Photos app before. Adding the Levels panel to
your toolkit gives you some serious control over your images,
enabling you to quickly adjust colour casts and light levels from
one place, without having to use multiple sliders. The results are
absolutely fantastic, especially in photos in which some colours
dominate others, and this control can make even the most
washed-out image into something worthy of your wall. And,
unlike apps such as Photoshop that offer just three sliders for
adjusting levels, Photos has an impressive 12 sliders, giving you
more control than you could imagine.

1 Add the option 
Before you can edit, you’ll need to add the 
option to your Adjust panel. Click the Add 
button at the top, then select Levels from the 
drop-down menu to have it appear.

2 Use Auto feature
As with all of the adjustment options in 
Photos, you can quickly click the Auto button 
that appears when your cursor is over the 
section to instantly correct your image. 

3 Control black/white points
The sliders at each end of the Levels panel 
are the black and white point controls. These 
control the point at which areas become 
completely black or completely white.

4 Modify midtones
The central slider controls the midtones in 
your image – move it right or left to increase 
or decrease the brightness of these areas to 
your liking. 

5 Alter highlights/shadows 
The other two smaller sliders control the 
highlights and shadows in the image, or 
the colours between the midtones and the 
extremes of light and dark. 

6 Change the range 
You can also move the tops of the slider lines 
to manage the range of adjustment – for 
example, to adjust the lightest of highlights, 
move the top handle further to the right.

Adjust Levels to optimise photosStep-by-step

Make precise edits with the Levels tool
Enhance your images using the detailed Levels feature in Photos’ editing panel

Difficulty 

Download available

Time needed

10
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Remember, you can hold down the M key on your keyboard at any time 
during the editing process to compare your shot to how it looked before.

7 Access more options 
These changes are only those available in 
the RGB section. Click the menu button in 
the Levels panel to change to options like 
Luminescence and individual colours.

8 Control colour 
If, for example, your image has dominant 
green tones but lacks punchy red tones, you 
can select the relevant sections to adjust only 
these two colours.

9 Perfect and save 
Once you’re happy with the changes you’ve 
made with the Levels panel, you can continue 
editing, or simply click Done to save your shot 
and return to the viewer. 

Stay in control 
Master the Levels features with these tips 

 Stay in range 
You can use the Range sliders at the 
top of the Levels panel to select more 
specific areas of your light range to 
edit. Drag one over to the left, for 
example, to have closer control over 
the darker sections of your image.

 Fine-tuning 
If you want to get fine-tuning 
control over an adjustment that 
you’ve made, hold down the Alt 
key on your keyboard and drag 
the bottom slider on the Levels 
panel. This moves both the top 
and bottom sliders in unison.

 Combining adjustments
Remember that you can still add 
other adjustments and make 
other edits to your photos as well 
as using the Levels control – but 
we’d recommend that you make 
Levels a starting point. 

 Knowledge base
Auto, then tweak
As with all of the options in 
the Adjust menu, it is often 
a good idea to click the 
Auto button as a starting 
point to your edit. If you 
don’t like the change, 
you can always click 
Edit>Undo to get rid of it, 
but you can also use it as 
a basis for your edits and 
make small adjustments 
to what the Photos app 
does automatically.

 Histogram view 
It is recommended that you add the 
Histogram to the Adjustments menu to keep 
an eye on the overall effect that you’re having 
on your shot as you use the Levels control. 
The Histogram provides more detail.
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Photos

Working with RAW files in Photos
Reveal more colour and tonal detail by shooting and processing RAW-format files

Your iPhone stores photos as JPEG-format files; the advantage 
of a JPEG is that it can be uploaded instantly to social media 
sites, but the disadvantage is that it is a compressed file. If the 
camera fails to capture detail in a scene’s shadows or highlights, 
then this information can be impossible to recover in a JPEG file. 
With a JPEG you‘re also likely to notice nasty blocky compression 
artefacts in edited areas, as well as ugly colour noise.

A DSLR camera can produce uncompressed RAW format files. 
A RAW file has much more information stored in it, enabling the 
Photos app to recover more detail in underexposed shadows or 
overexposed highlights while keeping nasty artefacts at bay.

Difficulty 

Download available

Time needed

10

Get more from RAW
Highlight detail and reveal hidden shadows

 RAW vs JPEG
Here we have a RAW file and a JPEG 
file showing the same scene. In both 
images the sky is overexposed and 
lacks colour and detail, and the tree 
is underexposed. By adjusting the 
RAW file we can reveal more missing 
detail than we can when working 
with the JPEG.

 Metadata
Both the RAW file and the 
compressed JPEG were captured 
using the same aperture and 
shutter speed settings. You can 
see what camera settings were 
used to capture your photographs 
by pressing Cmd+I. 

 Lighten the shadows
The Shadows slider enables 
you to lighten underexposed 
shadows in both a RAW or JPEG 
file. However, a JPEG version 
will be more prone to displaying 
unsightly colour noise in these 
edited areas.

 Knowledge base
Belt and braces
If you want to compare 
RAW files with JPEG 
versions of a scene, then 
most DSLR cameras have 
a sub-menu that lets you 
shoot a RAW and JPEG file 
simultaneously. If the shot 
is exposed correctly, you 
will have a lightweight JPEG 
that you can share instantly 
online or via email. If there 
are exposure problems then 
you can process the RAW 
version to perfection. 

 Restore highlight detail
By dropping the Highlight and Exposure 
sliders you can reveal hidden detail in the 
brightest parts of a RAW-format file. The 
JPEG version of the scene lacks this extra 
information, so it can’t be recovered.
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1 Snap a shot
Capture a scene as a JPEG-format file. Then 
set the camera to capture a RAW-format 
version of the scene using the same camera 
shutter speed and aperture settings.

2 Summon shooting info 
In both versions of this image the sky is 
overexposed and lacks detail. Double-click the 
JPEG and click the Edit button. Hit Cmd+I to 
show the settings used to snap the shot.

3 Select Adjust option
By clicking Adjust you can drop the Exposure 
and Highlights sliders to reveal more sky detail. 
Here the Shadows slider lightens the dark tree 
and makes the image looks marginally better.

4 Open RAW file
Now bring the RAW version of the scene into 
the Edit workspace. You can see that you’re 
working with a RAW file in the Info window. 
Click the Edit button once again.

5 Reveal more detail
The Exposure and Highlights sliders can 
reveal more colour detail in the overexposed 
sky thanks to the extra information stored in 
the uncompressed RAW file.

6 Lighten the shadows
Push the Shadows slider right to lighten the 
underexposed tree without altering your newly 
revealed highlights. The RAW version now has 
more shadow and highlight detail.

Uncover more colour and detailStep-by-step

and choose a destination. Photos will create a JPEG version of the image.

A compressed JPEG provides a shorthand version of the
scene compared with the full story told by a RAW file. As a
result JPEGs are prone to suffer from artefacts, especially if
you edit them to lighten up shadows or boost colours. You
may not notice artefacts if your shared shots are viewed
on a mobile device. However, if you plan to print images or
sell them as stock photos, then shooting in RAW will keep
artefacts to a minimum.

1 Banding artefacts
A RAW file can display a sky’s changing colours 
as a smooth gradient. A compressed JPEG will 
provide a shorthand description of these 
graduated colours, producing noticeable bands. 
Compare the JPEG and RAW version above.

2 Noise artefacts
If you lighten up underexposed shadows you’ll 
reveal luminance and colour noise. Colour noise 
is present as a spectrum of blotchy colours. Click 

noise. Colour noise is less prominent in RAW files.

Identify artefacts

“JPEGs are prone to suffer from 
artefacts, especially if you edit 
them to lighten up shadows”

JPEG RAW
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iMovie

Some activities take their time to unfold, which can lead to a dull,
documentary-style video that no-one will want to watch all the
way to the end. Thanks to iMovie’s editing tools, you can turn
footage of a tedious, time-consuming task into a short, easy-
to-digest sequence. By cutting the key moments of an event to
music you can make the action unfold much more quickly. As
well as being easier to watch, a musical montage is easier to
edit, as you can jump cut from one moment to another without
worrying about continuity. The music helps unify the varying
contents and camera angles into a seamless snappy sequence
that will add variety and texture to any programme.

1 Import clips 
Choose File>New Event. A dated Event will 
appear. Relabel the Event ‘Montage’ and click 
the Import Media arrow icon. Shift-click to 
select our project clips and click Import All.

2 Add first clip 
Click on Shot01’s thumbnail in the My Media 
browser to select the clip. Click the + icon to 
add it to the timeline. Press Cmd+2 to access 
the Audio browser.

3 Turn on the music 
Click the clip. Scrub the playhead to where 
the man flicks the switch and press M to add 
a marker. Drag Barbeque Blues Long into the 
timeline to start playing at the marker.

4 Trim Shot02 
Press Cmd+1 to go back to My Media and 
drag Shot02 into the timeline. Place the 
playhead at the end of Shot02. Drag left to 
trim the shot so that it cuts as he stops drilling. 

5 Insert jump cut 
Add Shot03 to the timeline. Trim the start 
point so that the man immediately jumps to 
the floor. Trim the end of the clip just as he 
begins to drop the brick out of shot. 

6 Ensure continuity of action 
Add Shot04. Trim the start point so that the 
man’s movement matches the previous shot’s 
action. Press R and select the gap between 
the two brick drops. Right-click and Delete.

Cut your clips to musicStep-by-step

Create a musical montage
Shorten long events by cutting and mixing to music

Difficulty 

Download available

Time needed

20
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To identify a clip in the Project window, simply park the cursor on it. A label 

7 Add final shot 
up the workman’s brick-shifting progress 
and adds momentum to the sequence. Add 

8 Incorporate transitions 
To add more motion and texture press 
Cmd+5 to go to the Transitions browser. Place 

click the Transition to increase its duration.

9 Fade audio 
Add a Mosaic transition at the end. The music 
is a little too long, so trim it to end with the 
video. Drag the music track’s Fade audio out 
icon so that it ends during the transition.

Cut to a music track
Make a musical montage using markers and transitions

 Make your mark
Blue markers help you identify key 
points in a video clip. This marker 
represents the moment a worker flicks 
a switch, which acts as fun visual cue 
for our montage’s music to kick in. As 
the music track aligns with the marker 
a vertical yellow bar appears.

 Terrific transitions
These are a great way to move 
from one clip to another and they 
add extra texture to your project. 
The open-door movement of 
this transition complements 
the action nicely as a workman 
swings forward (see our Edited 
Montage Movie). 

 Time saving
By selecting and chopping out a 
boring section within a clip you 
can create a jump cut that keeps 
the action moving.

 Knowledge base
Match Color
To make your montage 
have a more coherent look, 
you can adjust one clip’s 
colours and tones so that it 
matches those in another. 
Select a clip and click the 
Color Balance icon. Click 
Match Color and scrub the 
eyedropper to a frame in the 
timeline that contains the 
look that you want. Click to 
make the original clip match 
the targeted one.

 Audio browser
By pressing Cmd+2 you can access the 
Audio browser. Here you can rummage 
through tracks in your iTunes Library or 
check out a wide collection of music tracks 
in the Jingles folder. You can add these 
Jingles to projects destined for YouTube 
without copyright worries.
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You may have used iMovie’s Clip Filter panel to quickly adjust
the look of your footage. This panel features 29 one-click effects
that can change colours and tones in creative ways, as well as
adding visual elements such as vignetted edges and film grain.
iMovie can work similar wonders with your project’s sound files
thanks to the Audio Effect panel that lives alongside the Clip
Filter. The Audio Effects panel contains 19 one-click preset
effects that can creatively adjust a clip’s audio properties in a
number of ways. As well as enhancing sound, you can also
use iMovie’s tools to overcome common audio problems using
preset Equalizer settings.

Difficulty

Time needed

20

1 Locate audio effects 
To creatively adjust a video clip’s sound, click 
on the clip (or on a green audio track such as 
a voice-over). Click the ‘Clip filter and audio 
effects’ icon above the viewer.

2 Preview sounds
Click Audio Effect. The Choose Audio 
Effect window will open. Click on a labelled 
thumbnail to preview how the selected clip’s 
sound will be affected by a particular preset.

3 Apply a preset 
Click to add a preset to your clip’s audio. You 
can make a subject sound like they’re talking 
in a small room (or a large cathedral) with a 
reverb-adding collection of audio effects.

4 Add echo 
When editing nature footage you can evoke a 
sense of space by adding an Echo Delay effect 
to a clip’s audio track. This mimics the effect of 
a voice bouncing back off distant hills.

5 Make a call 
In a drama you may need to include a scene 
where characters talk on the phone. You can 
record an unseen caller’s dialogue with a mic 
and add a tinny quality to their voice track. 

6 Muffle audio
If a character wears a mask it can be a 
challenge to capture clear dialogue. You can 
record a clear audio track and then make it 
sound muffled using a digital audio effect.

Digitally alter your clips’ soundStep-by-step

Apply creative audio effects
Enhance a project using iMovie’s audio assets and effects

iMovie
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Select and add audio effects
How to enhance a clip’s soundtrack

 Pitch perfect
To disguise a subject’s voice you 
can drop its pitch using this range of 
preset Pitch Down audio effects. For 
a more comical sounding voice, try 
applying one of the Pitch Up presets. 

 Improve sound quality 
To make an audio recording 
sound better, click this icon to 
access iMovie’s graphic Equalizer 
tools. You can also reduce 
distracting background noise 
using a tool from this section. 

 Access audio effects
After selecting a clip or voice- 
over track in the timeline, click 
the ‘Clip filter and audio effects’ 
icon to access the Choose Audio 
Effect panel with its nine sound- 
altering presets.

 Knowledge base
Sound levels
When recording sound 
on location, think of the 
phrase ‘garbage in, garbage 
out’. Although iMovie can 
increase a quiet track’s 
sound level, it runs the risk 
of adding horrible hiss. You 
could use the Equalizer 
to try and enhance the 
voice, but it won’t sound as 
good as audio that’s been 
recorded with correctly set 
sound levels. 

 Preview an effect
Simply let the cursor hover over a labelled 
preset to hear how it will alter the selected 
audio track. A red progress bar will scroll 
across the clip until the audio file has played 
all the way through.

When recording sound, wear headphones so that you can notice problems 

As we demonstrated in this tutorial, the Audio Effects
panel can adjust a clip’s audio channels to produce a
range of creative sound effects. However, in some
cases you may just want to overcome problems with
the original sound recording rather than creatively alter
it. In this instance you can turn to iMovie’s helpful noise
reduction and Equalizer controls. These help to improve
the quality of your recordings by changing sound
qualities such as bass and treble. 1 Remove unwanted noise 

The ‘Reduce background noise’ slider lets you 
diminish background sounds while preserving the 

slider too far to the right though, or their voice will 

2 The Equalizer
You can change a selected clip’s audio quality by 
clicking on one of the drop-down presets in the 

or reduce annoying hum caused by electrical 

Sound advice

“Improve the quality of your 
recordings by changing sound 
qualities like bass and treble”
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For those GarageBand fans that start to delve a little deeper
than the default, the app quickly reveals how sophisticated it 
really is. One key area essential for advanced mastering is the 
application of effect plug-ins to not just individual tracks but also 
the project Master Track. GarageBand bundles a fine selection 
of these studio-quality effects out of the box and adds them to 
library patches, while keeping things totally customisable. Any 
additional system-installed effect and instrument Audio Units 
(AU) plug-ins will be detected and listed for use in the same way, 
so in this guide we’ll look at how plug-ins are first added, then 
controlled using automations.

Difficulty

Download available

Time needed

30

1 Expand the inspector 
With a track selected, show the Smart 
Controls and then the inspector by clicking the 
top-left ‘i’ button. Inside, expand the Plug-ins 
area by clicking the arrowed label.

2 Locate Plug-ins menu 
Inside is a small box comprising four slots, 
occupied with plug-ins within the track patch. 
Hover over the edge of a plug-in or a vacant 
slot and click to show the menu.

3 Pick a plug-in 
You will see that plug-ins are categorised from 
Amps and Pedals through to Utility. If you pick 
a plug-in from Delay to Reverb for instance, 
the plug-in is added and the window is shown.

4 Edit manual effects
The plug-in window has a myriad of different 
parameters to tweak and affect the sound. 
Use the controls to dial in the effect as desired 
or control them with automations.

5 Select the automation 
Use the A key as a shortcut to showing track 
automations, then in the track header click the 
Automation pop-up and navigate to Plug-ins 
to select the parameter to control. 

6 Plot curve points 
The plug-in parameter curve is then shown 
running along the track. Automation points are 
then plotted to control each and every effect 
setting for the plug-in as required.  

Apply and tweak plug-in effectsStep-by-step

arageBand

Control plug-in effects with automations
Edit patch effects within the Smart Controls inspector and automate how they sound 
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Plug-ins work sequentially; the output of a plug-in placed above is sent to the 
input of the one placed below – reordering changes the sound dramatically. 

Plug-in effect essentials 
What to look out for in GarageBand’s interface when using plug-ins

 Plug-ins panel
Show the Smart Controls for a 
selected track and view the inspector 
situated to the left. In this panel you 
find the Plug-ins and an area to stack 
up to four within the patch. 

 Plug-ins rack 
Click an empty slot here and 
choose a desired effect from the 
category sub-menu to add plug-
ins. Drag the centre of the plug-in 
up or down to reorder or click the 
power button to turn off. 

 Effect plug-in window 
Here you will find a number of 
different sliders and controls for 
changing the settings manually. 
Hovering over a plug-in within 
the rack and clicking the middle 
button opens this window, 
although automations can also 
be used. 

 Knowledge base
Noise Gate and 
Master Effects
The plug-ins panel of the 
Inspector also features 
controls for additional 
effects. Noise Gate, which 
also appears for selection 
under the Dynamics category, 
uses a threshold level to cut 
low-level noise falling below 
it. Master Effects are the 
Echo and Reverb applied to 
the Master Track by default, 
so these can be toggled off 
or adjusted here also. 

 Automation curve 
View track automation curves via Mix>Show 
Automations or by pressing the A shortcut 
key. You can then choose a plug-in and 
a desired parameter to plot curve points, 
making changes automatically throughout 
project playback.

Effect plug-ins don’t only apply to each track in your
project – they can also be added and manipulated in
exactly the same ways using the Master Track. Most
useful for making those song-wide edits at the mixing and
mastering stage, you can again chain four plug-in units
here on top of the Master Echo and Reverb available by
default. The process is virtually identical and you can even
plot plug-in automations along the Master Track too, so
here we take a closer look. 1 Master Track plug-ins

Click the Master button above the Smart Control 
inspector to view the Effects, Output and EQ tabs 
for the Master Track. Select the Output tab and 
the inspector will show the plug-in slots for the 
whole project, which can be changed as before. 

2 Master Track automations 
Click Track>Show Master Track and ensure 
automations are also shown. Any applied plug-ins 
will be listed under Output, showing the various 
effect parameters available for the curve. You then 
plot your points the same way. 

Project-wide plug-ins 

“You can again chain four plug-in 
units here on top of the Master 
Echo and Reverb”
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arageBand

Add, customise and transpose loops
Drag loops into your projects to make edits and shift keys before saving back to the library 

At its core, GarageBand is very much a loop-based music 
production suite that makes the generation of songs quick and 
incredibly effective. Short passages of audio can be extended out 
over desired durations, forming repeating backing tracks that happily 
follow project tempo and pitch. New Apple Loops can be added to 
GarageBand as downloadable packs, while you can of course add 
your own loop creations to the library for future reuse. These can 
be re-edited where required, while changing the pitch to fit different 
songs. We’ll look specifically at loops and how existing ones are 
added to projects, how new loops are added to the library, how to 
customise them and also how to effortlessly transpose the key.    

Difficulty 

Download available

Time needed

20

Look out for loops
The pivotal parts of the GarageBand workspace for working with loops 

 Region transpose 
Select the loop within the timeline of 
the track, then show the Track Editor 
to access this slider within the Audio 
Editor inspector’s Region tab. Drag 
the slider left or right to transpose by 
desired semitones. 

 Dropping loops in 
Loops can be placed into a 
project by dragging and dropping 
within the main Tracks area. Drag 
a desired loop from the Loop 
Browser to an empty area below 
the tracks or an appropriate 
existing one.

 Looping regions 
GarageBand makes it easy to 
loop audio by hovering over the 
top-right corner of the end of a 
region before clicking, holding 
and dragging out. Looped regions 
show top and bottom notches at 
each loop point. 

 Knowledge base
The art of looping
Creating effective loops 
within a current project or 
from the library is something 
of a skill most beginners 
must master. Whether 
creating new loops or 
customising existing ones, 
it’s important to size the 
initial region accurately so 
that it loops seamlessly. 
Remember that any portion 
added or subtracted, 
including silence, is looped 
during playback.   

 Loop Browser 
Shown to the right of the main track’s 
workspace, this panel is used to browse 
available Apple Loops and any added to the 
library. Search directly or use the keyword 
buttons and category columns to filter results. 
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1 Add to project 
To begin, you’ll need to head to the Loop 
Browser. GarageBand’s library of available 
loops can be searched and filtered here, 
before dragging any into the Tracks area.

2 Loop in track 
New loops are dragged into existing matching 
track types or automatically placed into a new 
track. Once within a track, the loop can be 
edited like any other audio region.

3 View in Audio Editor 
Customise the first instance of a loop, making 
any edits to that first non-looped region. 
Double-click it to show within the Audio Editor 
or via View>Show Editors (E).  

4 Cut loop regions
From here you can split or cut down the 
region as required. Halving a selected loop 
can be achieved by highlighting and deleting, 
or simply dragging the region shorter. 

5 Extend loop regions 
Conversely, loop regions might be extended 
by desired duration by hovering over the 
bottom-right edge, clicking and dragging – 
either to show more audio or add silence.

6 Preview looped playback
The yellow cycle area can be positioned above 
a region on the timeline to preview how it 
loops during playback. Turn on via the control 
bar button or with the C key.   

7 Loop audio regions 
Audio regions of all kinds, particularly Apple 
Loops, can quickly be looped along the track 
timeline by simply hovering over the top-right 
corner, clicking and dragging.

8 Transpose loops 
Loops can be transposed or have their keys 
shifted by using the slider found in the Audio 
Editor’s Region tab. Drag to shift pitch up or 
down by a number of semitones. 

9 Add to library 
To add your edited loop back into the library, 
simply drag it onto the Loop Browser. You are 
then shown a prompt for naming and tagging 
the customised loop as appropriate.

Apply and edit loopsStep-by-step

Regions relate to any track audio and include recordings, Apple Loops, MIDI 
regions, imported audio or Drummer regions – all of which can be looped. 
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Logic Pro X

Use Logic’s Plug-in Manager 
Keep your favourite plug-ins close at hand with Logic’s helpful assistant

Logic Pro X makes a great host for third-party instrument and 
effects plug-ins, enabling you to build up as big a collection of 
goodies as your bank balance will allow. However, when you call 
up non-Apple plug-ins on your system, the way in which they’re 
listed by default isn’t the most intuitive – you have to select the 
manufacturer name before you actually get to see the name of the 
plug-in itself. Fortunately, Apple has provided a way around this that 
lets you organise and manage your plug-ins effectively, by creating 
new categories or searching for plug-ins by type. So follow along as 
we demonstrate how the Plug-in Manager can make your Logic life 
easier by speeding up access to your favourite processors. 

Difficulty 

Download available

Time needed

20

Mighty manager 
Sort your plug-ins list and speed up your workflow 

 One for all
Logic can distinguish between effect 
plug-ins and software synths, so 
changes made in the Plug-in Manager 
are reflected in both Instrument and 
Audio FX menus as required.

 Top level
Items placed in the top level appear 
directly at the top of the plug-in menu 
when you click and hold on the insert 
slot, allowing quick and easy access 
to your favourite stuff.

 Decategorise
If you want to remove a plug-in 
from a category, just right-click 
its name and select Remove. This 
just removes it from the category, 
not from your system!

 Restore default settings
Click this option to remove all 
edits made to the plug-in menus 
and restore the Manager to its 
factory settings.

 Knowledge base
Plug-ins baby
Logic ships with a generous 
helping of its own instrument 
and effect plug-ins, which 
are all nicely categorised 
already. When you add any 
additional plug-ins that you 
subsequently install to the 
list via the Plug-in Manager, 
they join the Logic plug-
ins in those predetermined 
categories. New categories 
are also added to the list, 
but only if you’ve actually 
added a plug-in to them.
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1 View plug-in menu
In the Inspector, click and hold on a channel’s 
Audio FX slot. By default, Logic plug-ins are 
already categorised, with third-party plug-ins 
listed by developer under Audio Units.

2 Open manager
To start organising this menu more to your 
liking, begin by selecting the Plug-in Manager 
option from the lowest pane of the Logic Pro 
X>Preferences menu.

3 Select Show All
After clicking this option, a window will appear 
showing the list of all current categories down 
the left side, with a list of all the plug-ins 
detected on your system down the centre.

4 Drag it
In order to categorise an item, simply drag its 
name from the main central list into one 
of the category folders in the list on the left-
hand side.

5 Work through
If you have a lot of plug-ins installed, simplify 
the process by working your way down the 
manufacturer list and categorising each 
developer’s items individually.

6 Create new category
This can be done by clicking the small grey 
+ button. Give your category a name and hit 
the Return key, then drag it to the required 
position in the list.

7 Manage your favourites
As an example, here we’ve created a 
Favourites category and dragged across a 
selection of our most often-used processors 
and synths. 

8 Finish it up
When you’ve finished dragging plug-ins 
around, click the Done button in the lower 
right-hand corner of the window to complete 
the process.

9 View your new categories
Logic will take a couple of seconds to initialise 
the Core Audio driver. When you click on 
the Audio FX slot again, the updated list of 
categories will appear.

Organise your plug-insStep-by-step

You can add a plug-in to more than one category if you wish. It will appear 
in all of them in the plug-in menu.
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Final Cut Pro X

Add atmosphere to your projects
Creatively adjust colours and tones to change the mood of your original footage

Most video cameras attempt to capture an accurate representation 
of a scene’s colours and tones. However, you may want to change 
the look off your footage for a variety of creative reasons. By 
tweaking colour and tone you can give ordinary video footage a 
more stylised filmic look. You can also manipulate the viewer’s 
emotion by using colour to evoke a particular mood. Our example 
project was shot on a relatively sunny day, but by adding a cool 
wash of colour we introduced a more menacing vibe to our 
character’s walk in the woods. Color Board enables you to tweak 
colour and tone using control points, and you can also change the 
look of your footage by modifying effect filters to suit the scene.

Difficulty 

Download available

Time needed

10

Add mood-changing effects
Grade colours and tones by modifying effect layers

 Manual adjustments 
By dragging this oval shape you can 
simultaneously adjust the position 
of the Falloff and Size sliders in the 
Inspector’s Vignette effect layer. This 
lets you make the edge shadows close 
in around your actor.

 Copy and paste
After spending a while grading a 
shot with multiple effect layers, 
you can copy the multiple effects 
and paste them quickly into a new 
clip. You can customise which 
effect attributes are pasted by 
ticking these boxes.

 Effects browser  
The Effects browser groups 
effects in categories to help you 
find particular looks more easily. 
The Vignette effect lives in the 
Stylise category. Drag an effect 
onto a clip in the timeline to 
instantly change its look. 

 Knowledge base
Tweak effect layers
You can change the look 
produced by multiple effect 
layers by reordering the 
layers in the Inspector. 
Simply drag them up or 
down in the layer stack. You 
can also turn a particular 
effect layer on and off by 
clicking its adjacent blue 
square icon. This helps you 
see exactly what each layer 
brings to the mix.

 Adjust effect properties
Effects appear as editable layers in the 
Inspector. Each effect layer has its own 
adjustable sliders to change a range of 
properties (such as the amount of blur at the 
edge of a vignette). 
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1 Use Color Board
Click to select a clip in your timeline. In our 
example we have a sunny bluebell wood. For 
a moodier look click on the Enhancements 
menu icon and choose Show Color Board.

2 Tint the tones
Click the Color icon. By dragging the Shadow, 
Midtone and Highlight control points up into 
the + blue section, you can add cool washes 
of colour to these tonal regions. 

3 Darken the shadows
Now click on the Exposure icon. Drag the 
Shadow control point downwards to darken 
the shadows and complement the cool 
colours. Our woods now look more menacing.

4 Open Effects browser
The Color Board can produce a range of 
results with a bit of tinkering, but for a quicker 
mood change choose a new clip to adjust and 
press Cmd+5 to summon the Effects browser.

5 Drag and drop 
In this browser, click the Looks category. Drag 
Cold Steel onto your clip in the timeline. This 
dramatically changes the colours and tones of 
the clip in an instant. 

6 Modify the effect
Click the arrow at the top left of the Color 
Board to go to the Inspector. Drop Amount to 
55 for a subtle adjustment. Set Protect Skin to 
32 so warmer hues aren’t cooled as much.

7 Add a vignette
Go to Stylize and drag Vignette onto the clip. 
In the Inspector, adjust the Vignette section’s 
sliders to make the edges of the frame blur 
and darken menacingly around the frame.

8 Copy effect settings
Once you’re happy with the look produced by 
the combined effects, click on the adjusted 
clip in the timeline. Choose Edit>Copy. Then 
click to select another clip in the timeline.

9 Choose attributes to paste
Choose Edit>Paste Effects to add all 
the copied effects to the new clip. Click 
Edit>Paste Attributes to choose which effects 
you’d like to paste into a new clip.

Alter the look and mood of your programmeStep-by-step

Cmd+4 to hide it. This lets you view your programme in a larger window.
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Airmail 3

Apple’s Mail application has served millions of Mac users very
well over the years, with the occasional blip sneaking in on
occasion. It is a minimalist solution that will do what you need,
but one thing it lacks is personality and the ability to navigate
the interface in a natural way. With Airmail 3, however, you get
a familiar-looking email app that is pleasing to look at, but with
a selection of useful shortcuts and gestures that may make you
think twice about Apple’s default solution. We will highlight the
most important features and also show you how to quickly set
everything up, but spending time checking out all the features on
offer will pay off in the long run.

1 Buy the app 
You will need to purchase Airmail 3 from the 
Mac App Store to use it, but the good news is 
that the asking price is reasonable for an app 
you will likely use every day. 

2 Allow access 
To make the most of the Airmail 3 experience, 
you will need to allow access to your calendar 
and reminders. The prompts for these will 
appear when you open the app. 

3 Select your account 
Click the drop-down box and select your email 
service. The settings you require should be 
included automatically so you can just enter 
your email address and password. 

4 Trust the app 
When the panel appears asking you to give 
the app access to various features, you will 
need to accept these. Trust the app and you 
will be rewarded with functionality. 

5 View emails 
As soon as you accept the accesses required 
in the previous step, you will see all of your 
latest emails and any folders you have set up 
appear in the app immediately. 

6 Make a signature 
Even if you already have an email signature, 
you will need a create one in Airmail 3. Go to 
Preferences>Accounts and click the small cog 
icon. Now click Signature.

Manage your emails differentlyStep-by-step

Use Airmail 3 instead of Apple Mail 
Get to grips with this advanced and clever Apple Mail alternative

Difficulty 

Download available

Time needed

10
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7 Drag and drop 8 Create Memos and To Dos 9 Change the theme 

A near-perfect interface 

 Easy navigation
Gestures are included that make the 
app feel like an iOS solution on a Mac. 
You can swipe to delete and pick up 
emails with one click. It’s the perfect 
mix between mobile and desktop. 

 Do more 
The ability to handle emails is 
supplemented with the quick 
creation of Memos, To Do items, 
calendar entries and much more. 
You can also share items with the 
most popular social networks. 

 A brilliant design 
The layout of Airmail 3 fits the 
Mac OS X interface perfectly, to 
the point that it feels as if Apple 
made it. For many, it surpasses 
the clean lines of Apple Mail.

 Knowledge base
Customisation
Go to Preferences>Actions 
to see a range of options 
that you can tweak to suit 
the way you work. The 
app lets you customise 
what happens when you 
use the arrow keys, menu 
buttons, Spacebar and the 
actions when you swipe 
on a trackpad. You really 
can make the Airmail 3 
experience unique to you 
and your preferences. 

 True connectivity 
From the moment you input your email 
account details, Airmail 3 will retrieve your 
folders, latest messages and everything 
else you need to start communicating 
straight away. It’s also extremely stable over 
prolonged periods.
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Automator

Top 10 
Automator 
scripts

Automator is a tool bundled with OS X that enables you to 
perform time-consuming tasks and functions efficiently and 
with little effort. It can make your life easier by automating 
repetitive tasks and performing functions quickly and easily. 
Automator creates programs, but this is a drag-and-drop 
environment with no coding required. Simply drag functions 
out of a library and drop them on a workflow to create apps.

Some of the workflows, which you’ll find on our FileSilo 
downloads page, must be loaded into Automator and 
customised, whereas others run without change. You can 
create your own and they often consist of just one or two 
library functions; the description or screenshot may be all you 
need to recreate them. Open Automator and experiment!

Save time and effort with 
these workflows for OS X

Save web pics
While browsing the 

web in Safari, you 
can save all the 

images on the current 
webpage with Save 

web pics.app. It 
automatically creates 

a folder on the desktop 
based on the domain 

name and then 
helpfully saves all 

the images in it.

Backup
This is an 

Automator script that 
must be configured 

before use. Load it and 
on the right you’ll see 
Get Specified Finder 

Items. Add folders you 
want to back up. In Copy 

Finder Items below, 
click To, click Other and 
select a disk or server to 

save the backup to.

Create 
app shortcuts

Run any app with a 
keyboard shortcut. 

Open Automator, select 
Services, drag Launch 
Application to the right 

panel and select an app. 
Save it. Open System 

Preferences>Keyboard> 
Shortcuts>Services. 

Select your service and 
add a shortcut. See Run 

an app.workflow.

Size Safari
Apps don’t always 

open with the size or 
position you want, so 

Size Safari.app enables 
you to set both. Load it 
into Automator, replace 

Safari with any app 
name and change the 

coordinates (top 
left, bottom right) 

in order to set your 
preferred size.

Compress 
PDF images

PDF files can grow quite 
large if they contain lots 

of images. This can 
make them awkward for 

Mail or sending with 
Messages. Drag a PDF 

file and drop it on 
Compress PDF images.

app. It will compress 
the images then save 

the PDF as a much 
smaller file.

Alarm
You can now use your Mac as 

an alarm clock! Create a Calendar 
Alarm in Automator and set it 

to play iTunes music. Set the alarm 
time in Calendar and then set 

the Mac to wake five minutes before. 
See the annotated screenshot for 

more details.
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Musical alarm

 Schedule alarm
Head to System Preferences>Energy 
Saver, click Schedule and set a time 
for your Mac to wake up. This is so it 
can be put into Sleep Mode at night.

 Choose the music
Add Get Specified iTunes Items to 
Automator. Click the Add button below 
and then select the music you want to 
play as the alarm. You can add either 
tracks or playlists.

 Rise and shine
When Calendar events are created 
in Automator, they appear in the 
Calendar. Change the time to five 
minutes after the Mac wakes up.

 Start iTunes
Add and save the Start iTunes Playing 
workflow and it automatically appears 
in Calendar as an event. You can then 
edit it and set the time for the alarm 
your Mac will wake up with every day.

 Knowledge base
Script types
If you create an Automator 
application, it is saved as a 
.APP file. This can be run by 
double-clicking it, or it can 
be loaded into Automator 
and modified. You need 
to do this with some of 
the workflows. A service 
is saved to your Library> 
Services folder and can be 
deleted from there if desired.

Quick 
Calendar event
This short Automator 
script enables you 
to create an event 
in Calendar without 
opening the app. Just 
double-click Quick 
Calendar event.app 
and fill in the details as 
you normally would in 
Calendar, even though 
it’s not open.

Save web text
If you are researching 
on the internet and 
find a page with lots of 
useful text, you could 
select it, copy it, paste 
it somewhere then save 
it. Instead, save yourself
effort by running Save 
web text.app to save 
the page open in Safari 
as a TextEdit file on 
the desktop.

Resize images
If you need to resize a 
collection of images, 
perhaps for emailing, 
posting in the web and 
so on, this workflow 
service does the job. 
Select one or more 
images in Finder, 
right-click them, select 
Services>Resize Images 
and enter the size. 
Warning: it overwrites 
the originals.

Quit all apps
There are two apps here, Fast Quit.
app and Safe Quit.app. Run them 
to clear your desktop or shut down 
quickly. Safe Quit prompts you to save 
any unsaved work before closing apps, 
whereas Fast Quit doesn’t. Load the 
apps into Automator and experiment to 
see how they work.
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Over time, it is possible that some small niggles will crop up
if you use your Mac every day. These are largely unavoidable
and can be difficult to narrow down, but there is a simple reset
process you can perform which will change many parts of Mac
OS X back to their default settings. If you are struggling with
speaker volumes, or getting no sound at all, this process can
help. It will also help with screen resolution issues, startup disk
problems and the default time zone settings. It is, of course, not
a guaranteed solution to all problems in these areas, but it only
takes a few seconds to complete and is always worth a try to see
if it completes the quick fix for you.

Solve a variety of problems by resetting NVRAM with this handy tutorial

There are few visual clues to show that
the NVRAM reset has completed, but
there are simple ways to double-check
that it has worked as expected.

1 Shut down
The first step is to shut down your Mac. In
theory you can do this the normal way, but we
would advise to close all running apps first just
to be on the safe side.

2 Perform the reset
Turn on your Mac and hold down
Cmd+Alt+P+R after you hear the startup
sound. When you hear the second sound, you
should release the keys immediately.

3 Complete reset
The screens will flow as normal and it can be
difficult to know if it is complete, but if you
keep the keys pressed down you will see a
white screen continually cycle.

4 Check Find My Mac
Find My Mac will likely be disabled when you
reset NVRAM, so make sure that you go to
System Preferences>iCloud to enable it again.
There will be no warning for this.

Reset NVRAM in secondsStep-by-step

1 Listen out
The second startup sound is highly likely to be 
louder or quieter than the first one, which shows 
that the default volume has been changed by the 
NVRAM reset process.

2 Review settings
You should now inspect the screen resolution 
settings as well as the time zone and startup disk 
settings. Hopefully, any small niggles you had will 
now be resolved forever.

Confirm the reset

Difficulty 

Download available

Time needed

2

OS X

Quickly reset your Mac’s NVRAM
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1 Open Network preferences
Open System Preferences and then click
Network. Select the network you normally
use, such as Wi-Fi or Ethernet, then click the
Advanced button at the bottom to configure it.

2 Check DNS settings
Two DNS servers (two sets of numbers) are
always listed here. If no DNS servers are
specified or you delete what’s here, the Mac
automatically fetches them from the router.

3 Go to OpenDNS
Head over to opendns.com. Scroll down to
the bottom of the webpage and you’ll see two
sets of numbers. These are alternative DNS
server addresses anyone can use.

Increase internet security with OpenDNS
Many technologies come together to make the internet what it 
is and DNS servers are hidden, but vital components. It doesn’t 
matter what they are or how they work, you just need to know that 
you are not limited to the ones provided by your ISP and there are 
alternatives. By using faster DNS servers you can speed up the 
internet, or by using filtering you can block harmful or undesirable 
web content and make the internet safer and more secure.

The Mac automatically uses the DNS servers provided by 
your ISP, but you can specify alternatives, such as the popular 
OpenDNS servers. They are designed to be faster and more 
secure, and offer features not available with your ISP’s servers.

Avoid the worst of the web by switching DNS servers

4 Add the servers 
Switch back to Network preferences. Click 
the plus button below the DNS server list and 
copy the two IP addresses from the OpenDNS 
webpage. Close System Preferences.

5 Get an account 
Your Mac is now using OpenDNS servers, 
which provide fast and safe internet access. 
Click the Personal menu on the OpenDNS 
homepage and there are two free accounts.

6 Sign up
We chose the free OpenDNS Home classic 
account, which enables you to configure the 
options yourself. Click the Sign Up button and 
complete the form.

How to switch DNS serversStep-by-step

OpenDNS

Difficulty 

Download available

Time needed

10
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How do you go back to the original DNS servers you had before? Return to 
Network in System Preferences, select the DNS servers and delete them.

Customise OpenDNS
Filter the internet and see only what you want

 Settings menu
The page showing is Web Content 
Filtering, but there is much more. 
Select each of these menus and 
configure the options, such as whether 
to log activity, enable extra security 
options and so on.

 Custom filtering
Select the Custom option 
and a long list of web content 
categories is displayed. Tick the 
boxes next to the items you want 
to block, such as alcohol, drugs, 
gambling and so on.

 Set the filters
There are several preset values 
for filtering undesirable web 
content, and selecting one of 
these is a quick way to configure 
your network. Click the View or 
Customize links on the right to 
change settings.

 Knowledge base
Update your IP
OpenDNS filtering works 
with an IP address. Many 
home users don’t have 
a fixed IP address and it 
can change, which would 
prevent the filters from 
working. On the Settings 
page and elsewhere is a 
link to download a small 
Mac app called OpenDNS 
Updater. Run it and it 
updates your account if your 
IP address changes.

 Your network 
Select the network to configure in this menu. 
Free accounts only allow one network, 
but it is possible to have several with paid 
accounts and they can each have different 
security and filter settings.

7 Add IP address
Select Settings and click Add This 
Network to add your IP address. Your settings 
apply only when you are connected to the 
internet through this address.

8 Select the network 
You could have networks for home, work and 
elsewhere, but free accounts allow only one. 
On the Settings tab, select the network you 
just added. We called ours Home.

9 Enable web filtering
OpenDNS can block undesirable websites and 
you can select the level of filtering you want 
– High, Moderate, Low or None. We would 
suggest High for kids, Low for adults.
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Use WhatsApp on your Mac for free
It works brilliantly on your phone, but the WhatsApp experience is just as good on a Mac

WhatsApp

A bigger WhatsApp 
Enjoy a familiar interface on a larger screen 

WhatsApp currently has more than one billion users connected 
to the service, and as such it is one of the most popular 
communication tools on the planet. The interface is perfect for 
mobile and this has made it ideal for sending photos, documents 
and for chatting with friends when you have a few spare minutes, 
but when used on a Mac you can take the service even further. 
We will show you how to install the Mac app, and you may be 
surprised at how easy it is to set up, as well as the clever way it 
works with your phone to ensure consistency over every device 
you own. Potentially, you may find yourself using it as often as you 
do the phone app, which highlights how effective it is.

Difficulty 

Download available

Time needed

10

 As you expected 
The Mac WhatsApp interface feels 
familiar from the moment you start 
using it. The chat list is on the left and 
the main panel shows the selected 
conversation with little else getting 
in the way.

 Same as always
The other party in your conversation will 
see nothing different, whether you are using 
the phone or Mac to communicate. Emojis, 
photos and links all work exactly as they do 
on the phone. 

 Photos and documents 
The lack of complexity flows 
through to the way you can add 
photos and documents to any 
conversation. Indeed, it’s so good 
that it could easily become your 
main method to send files. 

 Knowledge base
WhatsApp on 
the web
You can also use WhatsApp 
without installing the Mac 
app. Head over to web.
whatsapp.com and then 
scan the QR code as you 
would when using the Mac 
app. You will only be able 
to use the Mac app or web 
version at any one time and 
will have to log out of one to 
keep chatting.

 Simplicity shines through 
There are minimal preferences to deal 
with in the Mac app, but you can still sign 
up for beta updates and change the main 
preferences when needed. It’s simple the 
whole way through.
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1 Download the app 
Go to whatsapp.com/download and follow 
the instructions to download the official 
WhatsApp software to your Mac. WhatsApp 
must already be installed on your phone. 

2 Scan QR code
You now need to open WhatsApp on your 
phone and go to Settings. Tap WhatsApp 
Web and use the camera to scan the QR code 
on your Mac. You are logged in immediately! 

3 Connect to Wi-Fi 
The app uses your phone and is effectively 
cloning what happens in the mobile 
environment, so you will need your phone to 
be within Wi-Fi range of your Mac. 

4 Share communications 
As you type a message on the Mac, it will be 
replicated on your mobile and vice versa when 
you use the phone app. Click the top-right 
paperclip to select a file to send. 

5 Select attachments 
When you click the paperclip, three icons 
appear. Click the top one to send photos, 
the middle one to take a photo with the Mac 
camera and the bottom one for a document. 

6 Deal with notifications 
Click the down arrow on the left side and then 
Settings. Now click Notifications to tweak 
desktop alerts, sounds and turn them off for 
a set period. 

Use your Mac to WhatsAppStep-by-step

goo.gl/IRBiv7 

Just like on the mobile app, you can ensure that
your WhatsApp profile is always kept up to date.
The process is simple and it is good practice to
update it once a day, especially so if you are a
heavy WhatsApp user with lots of contacts who
may want to get in touch. As before, every change
you make to your profile in the Mac app will be
pushed to the phone app.

1 Access profile settings
Click the down arrow and then ‘Profile and status’ 
to enter the menu panel you need. The number 
of settings in the Mac WhatsApp environment 
is deliberately limited to make the conversations 
shine through above everything else. 

2 Add text and images 
You can now select a picture to use as your 
profile picture and upload it immediately. You 
should also take time to add your own personal 
message to your status that will mean something 
to your contacts. 

Change your profile 

“You can ensure that your 
WhatsApp profile is always 
kept up to date” 
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You may own lots of different devices that are capable of
recording video, and these gadgets may well record video in a
range of file formats, such as .MP4, .AVI or Apple’s own .MOV.
However, different file formats can raise sharing issues. Due to the
varying codecs used to record your clips, file sizes may be too
large to send, or the format may not be suitable for streaming over
the web (or via Apple TV). Fortunately, Apple’s QuickTime app
is geared up to read a range of file formats and lets you export
them to formats suitable for a range of destinations, from iTunes to
YouTube. Here we’ll take a 4K GoPro .MP4 clip and convert it to a
more manageable HD .MOV format file to share via email.

How to transform clips into a more shareable format

Quickly convert a range of movie
formats to make them suitable for
sharing via a variety of destinations.

1 Open file in QuickTime
Here we’ve chosen a GoPro sourced .MP4 file.
At 4K resolution it’s too large to view at
full size, so we’ve used the View menu to fit it
in our display.

2 Summon Inspector
To find out more about the file press Cmd+I.
Here we can see that the file’s format is GoPro
AVC and its resolution is a whopping 3840 x
2160. The file size is 42.8MB.

3 Convert to HD
The 4K movie is too large in both resolution
and file size. To create a lighter HD resolution
file, choose File>Export>1080p. QuickTime will
convert the movie to a more shareable size.

4 Examine converted file
Our converted .MOV file has a smaller HD
resolution of 1920 x 1080, so will play without
the need for scaling. It has an email-friendly
size of 7.8MB thanks to the H.264 codec.

Convert and share filesStep-by-step

1 Export to iTunes
You can use the File>Export menu to convert any 
video file format to an iTunes-friendly shape and 
size, and then sync it with a gadget such as your 
iPhone or play it on Apple TV.

2 Share online
Instead of choosing File>Share, click on the 
sharing icon to the right of the playback controls. 
Choose an option such as YouTube to create a 
suitable format file for the desired destination.

To iTunes 
and beyond

Difficulty 

Download available

Time needed

10

QuickTime

Convert video formats
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GarageBand

Create vocal samples with the Sampler
Discover how to perform with samples using the powerful vocal Sampler instrument 

Difficulty

Download available

Time needed

20

Since the earliest days of electronic or synthesised music, 
musicians have found innovative ways of transforming the human 
voice. By recording, digitising and then processing vocals with 
a variety of synthetic effects, music-makers were able to assign 
these almost unrecognisable sounds to a keyboard. With each 
piano key triggering a voice at that desired pitch, the Sampler 
was born and eventually found its way into GarageBand iOS. Yes, 
with your iPhone and iPad you can easily capture vocals with the 
built-in microphone or load audio samples before using the Touch 
Keyboard to play them into your project. It’s a powerful and easy-
to-use feature with tools for organising a growing sample library.  

Capture and digitise vocal samples
Find your way around the Sampler instrument in GarageBand for iOS  Choosing sounds 

The New Sample button toggles 
recording mode while the My Samples 
button lets you choose and edit stored 
samples. The latter also shows the full 
keyboard controls for playback. 

 The keyboard 
The Sampler has a full keyboard 
with the same pitch/modulation 
wheels, sustain, swiping, scale 
and arpeggio controls as 
found with the Touch Keyboard 
Instrument (shown only in My 
Samples mode). 

 Sampler display 
The display area shows input 
levels and captured waveforms 
during record mode. With My 
Samples selected it shows 
recorded samples for the current 
song or the main library, for 
selection and editing. 

 Knowledge base
Touch Keyboard 
The Sampler keyboard 
shows the full Touch 
Keyboard controls when 
in My Samples mode. You 
tap each key to sound the 
selected sample at higher 
and lower pitches along the 
range, pressing multiple 
keys to sound chords. As 
with the Touch Keyboard you 
can change the layout, size 
and range while adjusting 
sensitivity or bending notes 
and adding modulation with 
the wheels. 

 The start button 
You can’t miss the big pulsing start button in 
the Sampler’s top left. This keeps recording 
your audio really simple, tapping it once to 
begin and again to stop. 
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1 New Sample mode 2 Tap to record 3 Preview and play 

4 Trim and Loop 5 Edit sample volume 6 Alter sample pitch 

Step-by-step

Add to Library Delete Samples Import to Sampler Input level controls
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Apple Music

10 reasons to 
subscribe to 
Apple Music

Apple Music is changing. At WWDC 2016, Apple announced it 
was refreshing the app for iOS 10 as it bids to tackle criticism over 
its rather clunky interface. But while those updates are not yet 
available, there’s no real reason to wait until they are implemented.
Even as it stands, Apple Music has more than a few innovations 
up its sleeve, making it easy to discover new music and get to 
the tunes you like the most. You can produce custom radio 
stations based on a song and create Genius playlists, and it hooks 
into iTunes too.

One thing’s for sure, Apple wants to topple Spotify: the market 
leader. So here are ten reasons why you will want to subscribe 
today – bearing in mind that the Apple Music experience is about to 
get a whole lot better.

Why you really need to dance to 
this brilliant app’s tune

Follow top people
Not only does Connect enable you to see 
photos and videos from your favourite artists, 
you can listen to demos and unreleased tracks 
too. Tap the speech bubble beneath each entry 
to read comments and connect with Beats 1 
DJs, seeing the tunes they play on each show.

Expert recommendations
Apple Music monitors the songs you like and 
listen to, making recommendations based on 

your taste. Apple doesn’t say exactly how it 
does this other than that they’re handpicked 

by experts, but it studies anything you 
‘heart’ or play and looks at your Library, 

genres and bands.

Play 
music offline

Given the precious 
nature of data plans, the 
ability to listen to music 

offline is important. 
Save a track by tapping 

the More icon to its right 
and selecting the 

download icon. You can 
then go to My Music 

and tap the sort menu, 
before choosing Only 

Downloaded Music.

Play it again, Sam
Navigate the accessible Apple Music interface

 Now playing
The currently playing tune is displayed 
at the bottom of the screen. Tapping 
this will show you the full set of 
controls and enable you to ‘heart’ it or 
replay. It also displays what’s up next.

 Share
Like what you’re 
listening to and also 
want the world to 
hear it? You can share 
any of your songs via 
social media or text, 
and you can copy a 
link to it too.

 Shuffle
Tapping the Shuffle 
button will randomise 
the order in which an 
album is set to play. 
You can also ask Siri 
to shuffle an album or 
playlist as you listen 
to it.
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While the sound quality may be 256Kbps as opposed to main rival Spotify’s 

Beats 1 radio
Apple disappointed fans when it failed to 
announce an expansion of its round-the-
clock global radio station. But with bands 
such as The Avalanches using it to debut 
new tunes and its musical range even 
surpassing that of Radio 1 and Radio 6 
Music, Beats 1 is top of the pops.

30 million songs
Like Spotify, a subscription to Apple 
Music gives you access to more than 30 
million songs, but it also makes it easy for 
you to listen to your own personal iTunes 
Library. If it finds music not listed in its 
own catalogue, it will upload them from 
iTunes on your Mac or PC.

Curated 
playlists
Within the New tab is 
a list of banners which 
let you view playlists 
that have been created 
by Apple editors, or 
put together based on 
a common theme. The 
Curator Playlists are 
our favourite, though, 
put together by experts 
including those from 
publications such as 
NME and Q.

There’s 
Force Touch
By pressing and holding 
down on the Apple Music 
icon, you can get to your 
music fast. The menu 
shows the current playing 
song, lets you go direct 
to Beats 1 and search 
the vast library. But that’s 
not all. Force Touch 
works in the app too, 
enabling you to preview 
whole albums.

It’s multi-device
As well as being able to use 
and listen to Apple Music on 
your iPhone, iPad and iPod 
touch, the app also works with 
the Apple Watch, letting you 
sync streaming playlists – on 
the Watch app on iPhone, go 
to My Watch>Music>Synced 
Playlist. Apple Music also 
works with Android.

Get it cheaper
So yes, £9.99/$9.99 sounds 
like a lot each month, but 
you can choose a family 
membership for up to six 
people for an extra fiver. 
Students get Apple Music for 
half price, and if you’re still not 
convinced and would like to 
try before you buy, there’s a 
free, three-month trial.

It uses Siri
When listening to a song, 
whether streaming, from 
your Library or via the radio, 
you can call up Siri and let it 
know whether you love or hate 
it (“I like/dislike this song”). 
Apple Music will make a note 
of that preference. You can 
also ask Siri to play specific 
or top songs.
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iOS

Connect to a VPN 
on your iOS device

A virtual private network is certainly handy in a variety of 
circumstances. It allows for extra privacy when using public 
Wi-Fi networks, it can mask your geographical location and it 
also blocks online trackers. Add to this the ability to avoid ISP 
throttling, and there is absolutely no reason not to at least try 
a VPN for browsing when home and abroad. There’s a host of 
them on the App Store, and many don’t even cost you a penny.

It is very easy to connect to a VPN from an iOS device as well, 
which we will demonstrate in this straightforward tutorial, and 
the hardest part of the process will actually be choosing whether 
to attempt to set up your own VPN or to try a paid-for service. 
There’s no right or wrong answer, so no matter what you decide, 
you will be able to take advantage of all of the benefits from your 
iPhone or iPad with ease. Let’s get started.

Set up a virtual private network in seconds for 
added security and protection

Set up and use a VPNStep-by-step

Difficulty 

Download available

Time needed

10

1 Locate the settings 
When you open Settings on an 
iOS device, you will see VPN 
listed near the top. You need to 
ignore this and scroll down to 
General. Tap it and scroll 
down to VPN. 

2 Add a configuration 
Tap Add VPN Configuration in 
order to start setting up your 
new access. You will need to 
ensure that you have all of the 
relevant information available 
before you start. 

3 Choose your type 
You should know your VPN type, 
but PPTP is the most common 
with L2TP offering little or no 
encryption. IPsec tends to be 
used in corporations and IKEv2 is 
common for mobile usage. 

4 Input the data 
Give the connection a description 
and then add the server address 
and remote ID if required. Every 
field should be completely 
accurate for the server you are 
connecting to. 
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A VPN is essential when using public Wi-Fi networks because it can shield 
your personal information from hackers. It should also hide your IP address.

Use a VPN app

Download an app
Apps like TunnelBear VPN are 
available on the App Store and work 
with an associated VPN service. 
These are perfect if the idea of 
building your own VPN at home is 
too time-consuming. 

Install to connect
You will need to create an account, 
but the actual VPN setup process 
couldn’t be easier. Once installed 
and signed in, you can tap Install 
and the connection will be available 
on your iOS device. 

Use the app
You can now utilise the a
the VPN on and to choo
where you want to conn
well as which geographi
you want to use. Every f
obvious and easy to use

5 Enter details 
The minimum requirements for 
any connection are the server 
name, username and password, 
but you must consider the 
authentication mechanism and 
ensure everything works securely.

6 Activate connection 
When all of the data is input, go 
to Settings and tap the icon next 
to VPN to connect. If you use 
more than one connection, you 
need to tap it and then decide 
which to use. 

7 Look for reminder 
When you are browsing or doing 
anything else with the VPN 
connection, you will see a small 
VPN icon at the top of the screen. 
It stays active until you disconnect 
from it. 

8 Connect On Demand 
If you want to use a VPN for every 
connection from your iOS device, 
make sure that Connect On 
Demand is enabled in the settings 
for your VPN. Leave it off to use 
it manually.



Use Google Maps 
when offline

Google Maps has long been considered by many to be one 
of the very best solutions for free navigation, but it has always
been limited by the need for a constant connection. This is
understandable, because the app does not include a map of
the country you are travelling in and so will pull the maps when
required – but things have changed recently. For a long time you
have been able to download areas so that you can view them
when offline, but now you can also navigate within them when
the mobile signal gets lost or if you want your phone to remain
in offline mode. This ensures a consistent navigation experience
and, as you will see, the set-up process is very simple.

You can now navigate with Google Maps even 
when you do not have an internet connection

Difficulty 

Time needed

1 Choose your city 
Search for a town or city using the top search 
bar. Tap the result and you will be presented 
with more detail about the location. Now tap 
the Download icon to proceed.

2 Check your space 
Make sure that you have enough space 
available and then tap Download again. It may 
take some time, but remember that a lot of 
useful information will be installed. 

3 Review your offline database 
At any point you can tap the top-left icon and 
then select Offline areas to check what is 
installed. Some areas require a lot of space, 
so only download essentials. 

Use Google Maps without a connectionStep-by-step

10

Google Maps
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Offline 
Google Maps

4 Begin search
While your device is offline, you can still search 
for any location if it is within a downloaded 
area. Everything looks the same as when you 
are online and searching. 

5 Navigate simply
Specific features such as traffic will not work 
while your device is offline. This is expected 
because it requires a constant connection to 
update the data in real time. 

6 Get travelling 
You can navigate within the downloaded area 
as you would normally when online. Voice 
commands and real-time directions all work as 
expected within the Google Maps app. 

Who needs a connection 
to navigate?

 Offline or no signal 
It makes sense to download locations you 
travel within often, and in particular if there 
are areas where the mobile signal is patchy 
or non-existent. 

 It’s quick 
You may even notice that the speed of 
searches feel smoother when the area has 
been downloaded.

 Search as normal 
The downloadable content includes the 
maps, navigation data and even voice 
commands. Every feature you need for basic 
navigation will be available to you. 

 There are exceptions 
Traffic monitoring will not work if your device 
is offline or if there is no mobile signal, and 
other features such as walking and transit 
modes also require a connection. 

 Knowledge base
Explore the 
advanced features
Some of Google Maps’ latest 
features are impressive. You 
can view indoor imagery for 
restaurants, shops, airports, 
museums and more, and 
you can also navigate 
through them. Potentially, 
Google Maps offers the 
most up-to-date coverage of 
any mobile mapping service 
available today. 

You should periodically check your downloaded content to make sure it is 
up to date. You can update the content with just one tap.
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Instagram

Use Instagram’s new 
OS share extension

With Instagram’s version 8.2 update, sharing photos and videos 
to your account and the wider world has been made much
easier. The app now has a share extension that enables you
to post unfiltered and unedited images direct from Photos or
another similarly functioning app.

The benefits are clear. Sharing images straight to your feed
without opening Instagram will be faster and much more
convenient. It also means you can use a third-party editing suite
and send photos via that instead. Make sure you download
the update regardless of whether or not you want this function,
because it fixes a few bugs and provides some improvements.

Now there’s a direct way to share photos and videos 
o Instagram on your iOS device

Difficulty 

Time needed

1 Install latest version
To use the extension, you need the latest 
version of Instagram on your phone. Once 
done, open an app such as Photos, select an 
image, tap Share, swipe right and tap More.

2 Activate the extension 
You’ll see a list of apps, each of which can be 
used within the Share function. Scroll down 
until you see Instagram and activate it by 
toggling the slide into the On position.

3 Create your post
The Instagram icon will now be placed within 
the share sheet. Now when you want to use it, 
tap Share on an image, select this icon, write 
your message and post it.

Activate and use Instagram’s extensionStep-by-step

2
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Use the iPhone Watch app
Make better use of Messages by delving into the settings

 Mirror my iPhone
If you want your Watch to behave in 
the same way as your iPhone, you can 
select to mirror it. Now when alerts are 
sent to your phone, they’ll also appear 
on the Watch.

 No sound
In a meeting and 
don’t fancy being 
interrupted by your 
Watch pinging when 
a new message is 
incoming? Toggle the 
Sound off and get 
some peace.

 Haptic
You can control 
whether or not your 
Watch buzzes on 
your wrist. Keeping 
Haptic on will ensure 
that you get a gentle 
vibration when a 
message is received.
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Apple Watch

Top 10 tips 
and tricks for 
Messages

If there is one thing the Watch has made redundant for those 
who own one, it’s the need to walk around with the iPhone 
glued to your palm in fear of missing a phone call or message. 
With the Messages app nestled nicely on the Watch, you are 
able to instantly see who is trying to get hold of you. You can 
navigate through your various text threads and even reply to 
any incoming messages.

Here we look at the ways you can make the most of the app, 
including speeding up your communication and helping people 
discover exactly where you are. We’ll look at some of the useful 
quirks of the Messages system and take a brief nosy at the 
iPhone app’s essential message-related features.

Communicate effectively with these 
tricks for watchOS’s Messages app

Utilise normal emojis
Of course, you are not restricted to 
the special Watch emojis. All of the 
standard emojis that you have become 
familiar with are available too. Keep 
swiping left on the emoji screen to find 
the comprehensive list and select the 
one that you want by tapping on it.

Use preset replies
When you receive texts, you can speed 
up your replies with a preset message. 
They appear when you tap Reply, but if 
you don’t like the default suggestions, 
go to your phone’s Apple Watch app 
and head to Messages>Default Replies 
to alter them.

Change your alerts
Your watch vibrates once when a message 
comes through, but if you feel that’s not enough 
and you’d like to have some reminder prompts, 
go to your iPhone Watch App>Messages and 
select Repeat Alarms. You can choose between 
a single alert or have as many as ten.



You are able to read any of the messages that ping through to your Watch by 
lifting your wrist. Just lower it again if you don’t want to reply.

Reply with audio
Once you have dictated your 
words, you will actually have two 
options. You can tap Send As Text, 
in which case your words will be 
sent as a normal SMS, or you can 
tap Send As Audio. The words you 
uttered will be saved as an audio 
file that can then be listened to by 
the receiver.

Share your location
Navigate to the thread of the person 
you want to share your location with 
and Force Touch the screen. You’ll see
three options – tap Send Location. 
The Watch will create a map of your 
whereabouts, which can open up in 
Maps when tapped.

Speak to send
If you would prefer to respond with some unique 

words of your own, you can make use of Siri on the 
Watch to dictate your message. Tap Reply and the 

microphone before speaking. The words will appear 
on the screen. Simply tap Done when satisfied.

Use special emojis
If a picture paints a thousand words, 
then what impact does an emoji have? 
Use them to respond to messages by 
tapping Reply and the face icon. There 
are three special emojis: face, heart 
and fist. Use the digital crown on each 
to see their variations.

Look up details
When you Force Touch the screen in 
a thread, you will also see an option 
for Details. If you tap this, the contact 
screen for your contact will appear and 
you can either continue to message 
them, give them a call or look up their 
address or other stored details.

Disable Message dictation
Whether you are replying or creating 
a new message (Force Touch in the 
message inbox), you may not want to 
have the option to dictate a message. 
If this is the case, speed things up 
by going to the iPhone Watch app 
and selecting Messages>Audio 
Messages>Always Audio.

Send Read Receipts
It’s possible for the sender of a message to know 

when you have read their text. But for this trick, 
you need to head to the Apple Watch app on your 
iPhone. Go to Messages>Custom and scroll down 

to the bottom. You will see an option for Send Read 
Receipts. Toggle it on.
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Apple TV is one of the most versatile set-top entertainment boxes
around, working seamlessly with your iDevices and Macs. It is
possible to use Apple TV to mirror your Mac’s screen, enabling
you to showcase presentations or highlight tutorials to others
without having them crowd around your laptop. You can also use
Apple TV’s display as an extended desktop.

Streaming videos from Safari or QuickTime Player is
straightforward enough. Just click the AirPlay icon within either of
those programs, but having the Apple TV mirror your entire Mac
desktop is something else. Find out how to do just that, and the
options to consider to make the most of this great function.

Difficulty

Download available

Time needed

10

1 Activate AirPlay
Your Mac can pick up on an Apple TV in its 
vicinity. Click the AirPlay icon on the right-
hand side of your Mac and select Apple TV 
from the drop-down menu under AirPlay To.

2 Resize resolution
Your Mac’s display will be mirrored on your 
Apple TV display. Click the AirPlay icon again 
and select Mirror Apple TV if you want your 
Mac’s resolution to match Apple TV.

3 Mirror iMac
Alternatively, if you would prefer your Mac’s 
native resolution to be mirrored on your Apple 
TV, select Mirror iMac (or, depending on your 
system, Mirror Built-In Display).

4 Have a separate display
As well as mirroring your Mac to Apple TV, you 
can use the television as a separate display. 
Select the option from the AirPlay menu and 
the desktop will immediately extend.

5 Use the display
If you run your mouse off the right side of your 
Mac, the pointer will appear on the TV. Go to 
System Preferences>Display on the Mac if you 
wish to rearrange the displays.

6 Turn off AirPlay
Once you have finished mirroring or extending 
your Mac’s display, you can turn AirPlay off 
by going to the AirPlay icon on your Mac and 
selecting the option Turn AirPlay Off.

Mirror your Mac on Apple TVStep-by-step

AirPlay your Mac’s screen to Apple TV
Beam movies and presentations to your Apple TV with AirPlay

OS X
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Use Apple TV as a separate display 
How to work with the Display options in System Preferences

 Arrange displays
Click one of the displays and drag it 
left or right. Which way you decide to 
go mainly depends on which side of 
the main display the Apple TV monitor 
is being positioned.

 Gather Windows 
When you open the Display 
option in System Preferences, 
option windows will appear on 
both screens. If you want to work 
with them both on the same 
screen, click Gather Windows.

 Display preferences
The preference windows 
on each monitor will let you 
change the display profile. This 
is mainly for advanced users 
– in most cases, you should 
leave it as the default.

 Knowledge base
Playing iTunes movies
If you are using iTunes and 
you want to AirPlay a movie 
to your Apple TV, you can 
do this very simply. Open 
iTunes and select whichever 
film or television programme 
you would like to enjoy and 
play it. You can then click 
the AirPlay button in iTunes 
and select Apple TV from 
the drop-down menu. The 
movie will play on Apple TV.

 Alter resolution
Click Display and you will be able to adjust 
the resolution for the monitor you are looking 
at. A similar option is also made available for 
the other display.

Fancy mirroring Apple TV on a Mac? Connect the two and go to File>New 
Movie Recording on QuickTime. Select Apple TV next to the record button. 

Sometimes things don’t go as planned, so if you can’t see 
any sign of Apple TV in the AirPlay menu, it may be due to a 
few factors. Firstly, you need at least a second-generation 
Apple TV, and your Mac has to typically have been bought 
since 2011 (for Mac Pros it can’t be older than late 2013 and 
for MacBooks, early 2015). Secondly, your software needs to 
be up to date and the firewall settings need to be activated. 1 Head to Firewall tab

Go to Apple>System Preferences>Security & 
Privacy and click the Firewall tab, then hit the lock 
icon before entering your computer’s administrator 
password. You can turn the Firewall to On for your 
protection. Now click on Firewall Options.

2 Change settings
Ensure ‘Block all incoming connections’ has been 
turned off and that the option for ‘Automatically 
allow signed software to receive incoming 
connections’ is on. Click OK and take another look 
at the AirPlay icon. It should show Apple TV.

Can’t see Apple TV 
as an option?

“Your software needs to be up 
to date and the firewall settings 
need to be activated”
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Genius Bar
Our Apple devices and the software on them are some of the finest computing 
products on the planet, but even they have their moments. That’s where we 
come in; to give you expert advice and get you back up and running in no time

Is it possible to choose the file or folder that my screenshots are saved to
when I take a screenshot using Cmd+Shift+3? James Barley

Glossary
The place to come for 
key technical terms made 
easy to understand 
PDF
This stands for Portable 
Document Format. 
Simply put, it is an 
electronic version of how 
a document would look 
when printed.

Adobe Illustrator
An app used by both 
artists and graphic 
designers to create 
vector-based images.

Podcast
A radio-style show that 
is prerecorded and can 
be downloaded and 
listened to anywhere, at 
any time.

Boot Camp
A system built into Mac 
OS X that enables users 
to install and run Windows 
on their Mac computers.

Jailbreak
A way of installing 
apps and software 
modifications that aren’t 
authorised by Apple.

Downgrade 
Uninstalling software on 
your Mac or iOS device 
and then reinstalling an 
earlier version.

Save screenshots to 
a folder rather than 

the desktop itself

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
icreatemagazine.com

Email
icreate@imagine-publishing.co.uk

1 Create your folder
Make a new folder on your Mac 
(anywhere you like) by right-
clicking in Finder and choosing 
New Folder from the menu.

2 Launch Terminal
Open the Terminal app (Applications>Utilities). Type the following 
command into the Terminal window: ‘defaults write com.apple.
screencapture location /path/’.

3 Change default screenshots folder
The ‘/path/’ element in the command is the location of your 
screenshots folder. If the folder is on your desktop: ‘/path/’ is ‘~/
Desktop/FolderName’. If you wish to save screenshots in another 
folder, the path is: ‘~/FolderName/’.
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1 Highlight the text
Launch Pages and open the
document with the text that you
want to change. Highlight the
passage of text.

2 Head to Font
Click Format and from the
drop-down menu, select Font.
From the pop-out menu, select
Capitalization at the bottom.

3 Change to lowercase
Choose None from the pop-out
menu. If you have a passage
written in lowercase that needs to
be in uppercase, choose All Caps.

My Keynote Presenter Notes are appearing 
on my external display when in Presentation 

mode. What am I doing wrong? Danielle Shane
It sounds like your Mac’s external display needs to 
be set up in a different way – it’s probably set up to 
be an extension of your screen, whereas for Keynote 
to work in Presentation Mode, your display needs to 
be set to mirror what’s on your laptop screen. To do 
this, launch System Preferences and click Displays. 
Click the Arrangement tab and then tick the box 
labelled Mirror Displays. Your external display might 
flicker off and on briefly while it makes this change. 

How can I quickly change a paragraph in Pages that was accidently typed 
in uppercase, to lowercase? Adrian Moore

Is it possible to open and edit a PDF document in Pages, or at least, 
convert it for editing? Mike Edmund

If the cost of Adobe Acrobat Pro makes your eyes water, you can break 
down the cost and pay a monthly subscription of £13.33/$14.99 instead.

 Cut and Paste
At the very least, you 
should be able to copy 
and paste the text from 
an open PDF in Preview 
into a Pages document. 
Be aware however 
that it won’t maintain 
any styling, such as 
formatting or fonts.

 Insert the PDF
You can copy and paste the PDF file into 
a Pages document. However, Pages will 
treat the PDF file as an image file, meaning 
you won’t be able to make edits besides 
resizing, masking and so on.

 Convert to Word
Use a third-party app such as Adobe 
Acrobat Pro to convert the file into a 
Word document that can then be opened 
in Pages. This route is quite costly – it’s 
around £450 for the latest version.

 Edit your PDF
To edit the text in a 
PDF (if it’s not copy 
protected), you will also 
need a third-party PDF 
editor such as Adobe 
Acrobat Pro, as Preview 
is limited to annotating, 
splicing and merging 
PDF files.

The one-stop
column for 
Genius advice
I have been sent some 
Adobe Illustrator files 
to edit but don’t have 
the Illustrator app; are 
there any alternatives to 
Illustrator that I can use?
Check out Affinity: a 
low-cost, high-quality 
alternative to Illustrator (and 
Photoshop, for that matter) 
– available for £40. Affinity 
Photo was voted Mac App 
of the Year by Apple in 2015 
– that accolade should 
speak for itself.

Is there a keyboard 
shortcut I can use to 
enter full screen in the 
app that I’m currently 
working in? 
There is, and thankfully, 
it’s a relatively easy one 
to remember: hold down 
the Cmd, Ctrl and F keys 
simultaneously when you’re 
ready to activate full screen 
in the app you’re currently 
working in. 

Is there a way to keep 
the menu bar visible 
when using full-screen 
mode in El Capitan? I 
like to keep an eye on 
the time!
The most straightforward 
solution is to set your Dock 
to auto hide (right-click on 
the Dock and choose 
Turn Hiding On). Then 
hold down the Alt key 
while clicking on the green 
maximize icon in the top 
left-hand corner of the 
app you want to run in full-
screen mode.

External displays should be set to 
mirror to work with Keynote
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I’ve found a new
podcast and want to

download some older
episodes, but I can only go
back so far. Where are
these older episodes
located? Diane Sharma
Unfortunately, the
publication of episodes falls
down to the podcast author/
distributor and not the app
itself. The author decides
how many episodes of a
podcast that they want to
make available for download
– some authors choose to
publish their entire back
catalogue, while others like
to publish only the most
recent episodes. Your best
bet to track down the errant
episodes is to contact the
podcast author directly.

I can’t remember
exactly when I last

backed up my iPhone to my
Mac. How can I find this out?
Nick Savage
Details about your last
iPhone computer backup are
contained within the iTunes
app on your Mac. Find out
when your last backup was
by launching iTunes and
connecting your iPhone
to your Mac. After a few
seconds, click on the iPhone
icon in the top left-hand corner
of the iTunes interface and
select the Info option from the
left-hand column. On the right,
you’ll see information about
your iPhone. Underneath the
Backup button, you’ll be able
to find the date and time of
your most recent backup.

The Moth podcast only publishes its 
most recently recorded episodes

Siri no longer recognises my home number when I ask it to ‘Call Home’.
How can I fix this? Jake Miles

Find your Contact
Ensure that your numbers are
labelled correctly with ‘Home’,
‘Mobile’ and so on. To change the
label, tap on its name and choose
an appropriate one from the list.

Launch Contacts
Open the Contacts app and
scroll down until you locate your
contact card. Tap to open your
card. Hit the Edit button in the top
right-hand corner.

Locate your info
Launch the Settings app. Scroll
down and tap on the Mail,
Contacts and Calendars option.
Tap on the My Info field which
will launch Contacts.

 Link with Siri
Scroll down to locate your 
contact card. Tap on it. Your 
name will appear in the My Info 
field. Now ask Siri to call your 
home number.

Genius Bar

The one-stop
column for 
Genius advice
What is the difference 
between an iPhone 
and iPad charger? 
Am I able to use both 
interchangeably?
The difference between 
the chargers is the 
amount of current it 
outputs. You can use both 
interchangeably, but your 
devices won’t charge any 
quicker as the device limits 
the amount of current it 
can receive. 

Can you recommend 
a good external 
hard drive that is 
interchangeable 
between both a Mac 
and a PC? 
Theoretically, you can 
connect any hard drive 
to a Mac or PC – what 
makes the difference is the 
way it is formatted. If you 
plan to connect it to a Mac 
and PC, format it in exFAT.

I have noticed a scratch 
in my MacBook Pro 
Retina screen. Are 
there any DIY fixes I 
can try to remove it?
Believe it or not, 
toothpaste can be used 
to patch some scratches. 
Actual toothpaste must 
be used. Gently massage 
the paste into the scratch 
with your fingers using a 
circular motion. The paste 
should adhere to the 
scratch and polish it away. 
Then use a soft cloth to 
remove excess paste from 
the screen. 



I have just restored my iPad but the £ sign is no longer 
visible as a menu option in Numbers. Tim Lane

I heard that iWork for iOS allows you to view old versions of your documents. 
Where can I find this feature? Emma Valaria

1 Launch the app
Open Numbers on your iPad. In the main 
Documents interface, where you open and 
manage your Numbers documents, tap Edit.

2 Select Versions
Next, choose the Numbers document that 
you want to view previous versions for. Then, 
tap on Versions in the top right-hand corner.

3 Browse and Restore
Tap on the version of the Numbers document 
that you want to view and tap Restore in the 
bottom right-hand corner.

I’m unable to share a Pages document via email 
on my iPad. What could be the problem? 

David Sterling
Lots of Pages users have reported this issue, leading us 
to believe that this could well be a sporadic bug in Pages. 
One workaround is to share your Pages document 
with Notes – if you have a Mac synced with iCloud, the 
document will appear in the Notes app on your Mac 
and you can attach it to your email from there. However, 
in some cases, a Pages bug won’t be the root of the 
problem. Pages documents, especially when containing 

lots of images and text, 
can end up being quite 
large files which are too 
big to email. If this is 
the case, your Pages 
attachment won’t send

Sync your Pages file wirelessly 
by attaching it to a note

I can’t back up some of my Keynote 
presentations when I try to export them 

via email. Are there any other ways to back them 
up manually? Sarah Ward
Your longer question mentioned that you don’t wish to 
use iCloud after a bad experience using it, so I’ll stick to 
other viable alternatives. Firstly, you could use another 
cloud-based service such as Dropbox or Google Drive. 
You manually upload your Keynote files to both of these 
services instead of your iPad automatically placing files 
there. Once you’ve uploaded your Keynote files, you can 

then log in on another 
device such as your PC or 
Mac and download them, 
creating another backup 
of the Keynote file.

Unable to email your 
presentation? Share it 
via Dropbox or Drive
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you to send large attachments up to 5GB via its Mail Drop service.

 Find iPad region
You might need to set your iPad’s 
region to the UK. To do this, launch 
the Settings app and tap General. Tap 
Language & Region.

 Set your region
In the Language & Region menu, tap 
the Region option and set it to United 
Kingdom. Press the Done button in the 
top right-hand corner.

 Format your cells
Tap the cells to be formatted with the 
£ sign. Tap on the paintbrush icon in 
the top right-hand corner to open the 
Format menu.

 Change currency settings
Tap on the ‘i’ icon next to the option 
labelled Currency. In the next menu, 
tap on the Currency option and set it to 
British Pound.



80

5 Keep it safe 
Pull the slide lock down and out of the Mac Pro to 
remove it. Keep it safe as you’ll need it to secure 
the new graphics card.

6 Take out the graphics card
Using both hands in either corner, slide the 
graphics card out of the slot, pulling away from the 
back of the Mac Pro where it is connected.

3 Remove a side
Pull the left-side panel towards you and lift off to 
remove. The graphics card is on the right-hand 
side, sat on top of the processor cage.

4 Unscrew the card
There are two screws to the right of the graphics 
card. Loosen the two thumbscrews by twisting 
anticlockwise until the slide lock is released. 

1 Unplug everything
Take out the kettle lead from the rear of your
Mac Pro and leave for five to ten minutes before
attempting your graphics card replacement.

2 Lift it up
Lift the lever on the left-hand side of the rear  
of the Mac Pro to unlock its case. Lift it up as  
far as it will go. 

I’ve got an older Mac Pro and want to upgrade 
my graphics card. Is it easy? Shane Martin

We love the original Mac Pro. It’s like a beautifully engineered piece of 
Meccano and most of the components are easily installed into a series 
of slots. After RAM and hard drives, the graphics card is one of the 
easiest installations or upgrades you can perform. It literally requires 
the power of your thumbs and not a lot else! We’ve teamed up with 
our wonderful friends over at iFixit.com to show you how easy it is to 
upgrade your graphics card in just six simple steps. Before you get 
started, check the manufacturer’s website for any drivers that need to 
be installed. For safety reasons, disconnect any peripherals (displays, 
keyboard, mice) from your Mac Pro before following this tutorial. 

The one-stop
column for  
Genius advice
I need to downgrade my 
iPhone’s iOS to perform 
some app testing. Is  
this possible?
Unfortunately, no. Apple 
restricts the downgrading 
of software for security 
reasons and often stops 
authenticating previous 
versions of an iOS once a 
newer version is released. 
You might have more luck 
if your iPhone is jailbroken.

I have two partitions 
on my hard drive. Can I 
upgrade the OS on one 
partition but not on  
the other?
Absolutely! When you run 
the Install OS X El Capitan 
app, just pick the partition 
you want to install it on 
to (the partitions will be 
mounted as separate 
volumes) – just make sure 
you pick the right one.

I’ve just upgraded to 
El Capitan and want to 
re-install my Windows 
Boot Camp partition, 
but Boot Camp 
Assistant is saying that 
my Mac doesn’t support 
Boot Camp.
Apple advises that a reset 
of your Mac’s NVRAM 
is required to fix this 
particular issue. To reset 
your NVRAM, restart your 
Mac and when you hear 
the startup chime sound, 
simply hold down the Cmd, 
Alt, P and R keys until 
your Mac switches off and 
restarts again. 

Genius Bar
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As someone using your Mac as a professional tool, it’s really important that you make a purchase that will
be flexible enough for upgrades when your needs change. Unfortunately, with the latest round of Mac
releases, it’s hard to find something that’s upgradeable, as many parts are now soldered to the logic board
in order to save space.

The result is that you have to splash a lot of cash now to future-proof your kit. However, that isn’t the only
option. Older models will support current technologies – compare a 2012 and 2014 Mac mini for example –
that are fundamentally the same design, however, internally they are quite different. Let’s take a look at the
current Mac mini model and compare the differences with an older model, offering you the insight to make
the right choice when investing in your new Mac.

Tools needed
Missing any of these?
You can order any
parts or tools you
might need from www.
ifixit.com/store.

(spudger)

If you would like more help with upgrading your Mac, visit the
gadget surgeons at iFixit.com, who kindly contributed these photos.

I’m a designer and looking to purchase a Mac mini, but want something
that can be upgraded. What do you recommend? Olivia Hill

Before purchasing a new video card for your Mac Pro, check that it will be 
compatible at 

An important note: the latest Mac mini is 

designed to make it harder to get inside 

 Getting inside

opening tool to get inside.

 RAM

 Flash storage
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Group test

Olixar Powercard Portable Charger
£16.99/$21.99

www.mobilefun.co.uk
While it might be a stretch to fit this charger in your wallet as 
advised (especially considering you need your own Lightning 
cable), we were mightily impressed by the Powercard’s size. 
At just 1,400mAh capacity, it’s barely going to charge your 
iPhone to 100 per cent, but it’s a great solution for anyone 
who doesn’t take a bag with them to work everyday. It’s 
a shame the USB doesn’t sit flush, but this is still a great 

emergency backup to have. 

Official Samsung Battery Pack
£9.99/$12.99

www.mobilefun.co.uk
This is a no-thrills approach from Samsung, providing you 
with the very basics at a ridiculously cheap price. Being an 

official Samsung product, you don’t need to worry about build 
quality. The glossy unibody plastic case looks very nice, while 
the solitary LED indictor is just about the only design feature 
to note. The 2,100mAh cell will fully charge your smartphone, 

guaranteeing peace of mind late in the day. Any official 
products this cheap should certainly come into consideration. 

Mophie Powerstation 
£69.95/$90.99

www.mobilefun.co.uk
Mophie is a market leader in the portable power bank market. 
It’s been there since the beginning, and those years of high- 
quality products mean you do pay a premium price. We can’t 

argue that you’re getting a great product. The design ethic 
is very much like Apple’s and the 6,000mAh battery will, for 
example, add 40 hours to an iPhone. The Powerstation will 

charge up to four times faster than your normal charger, and 
there are two USB ports for simultaneous charging.

Portable 
power banks
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STK Neptune 
£39.99/$TBA

www.stklife.com
The very best portable power banks need to be rugged. 
After all, they’re one of the few accessories we need that 
we don’t really care what they look like. They need to do 

a job, and that’s exactly what the STK Neptune does. This 
small, grenade-like charger comes with an IP67 rating, which 
means it’s waterproof, shockproof and even dustproof. The 
5,200mAh capacity will charge any iOS device twice, and 
there’s even an infrared pointer, torch and SOS signal light.

Danbo Power Bank
£19.99/$25.99

www.mobilefun.co.uk
As fans of Japanese comics will testify, Danbo 

is one of the stars of the manga comic series – and now 
his face has been transformed into a portable power bank, 
with pretty impressive results. The 4,200mAh cell is a nice 
compromise, and this is very compact and highly portable 

too – you could easily slip it into your top pocket or suit 
jacket. It comes with an automatic shutdown feature, and 

while our mocha brown review unit isn’t the prettiest, colourful 
alternatives are available.

Besiter Mercury Series
£34.99/$TBA
kavson.co.uk

For the price you’re paying, Besiter’s Mercury series is hard 
to match. You get a monster, MFi certified 10,000mAh battery 
that will charge your iOS device five times, while there are two 

USB ports for charging multiple devices at the same time. 
The battery indicator lights are very subtle, and size-wise 

you’re looking at a chunky iPhone 6s Plus. You do get 
a nice polished aluminium finish and tough plastic 
edges. There’s even a small Lightning cable that 

comes for free. 
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Key features

Reviews

This little speaker packs all the punch of the original Mu-so in a compact system. 
It’s certainly going to be an audible treat for your ears and for your wallet.

Naim Mu-so Qb

Verdict

Two passive bass radiators and a 
custom woofer drive the incredible low 
frequencies that come out of the Qb.

The touchscreen panel sits on an 
aluminium heat sink to make thermal 
performance even more efficient.

The midrange drivers are positioned 
close together, but they still provide 
top precision and stunning layers.
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Key features

A superb pair of headphones highlighted by their comfort and compactness. 
The price is a bit of a sticking point, but shop around to find a bargain.

Verdict

Pause your music without having to 
unlock your device by using the button 
on the headphone cord.

The wooden finish may be divisive to 
some, but the AH-MM400s look classy, 
despite mixing metal and plastic.

The AH-MM400s are easy to pack 
away and come with their own carry 
pouch for you to take on journeys.

Denon AH-MM400



86

Reviews

So you’ve bought yourself a spectacular 40-inch
4K TV and it’s got all the pixel power you want, but
it doesn’t have the audio to back it up? A solution
is to enhance it with a soundbar – and a quick and
cheap answer is the JBL Boost TV.

At only 38cm long, the Boost TV is smaller than
you might expect from a soundbar, which are
generally wide to generate as large a sound field as
possible. But JBL compensates for this the best it
can with two side-firing drivers, which make sure
you can still appreciate the built-in Harman Display
Surround sound even when you’re not sat directly
facing the speaker.

The cone-shaped soundbar has a wrap-around
grille with a thin strip of rubberised buttons on the
top, as well as a colourful orange base that you
don’t see once you set the Boost TV up. Given its
rubber controls and dinky design, you might mistake
the Boost TV for a portable speaker – but as it’s

intended to work with your television, the Boost 
TV doesn’t have its own battery and has to be
connected up to the mains.

The Boost TV also comes with both a 3.5mm 
analogue or optical cable, but either only takes 
a matter of minutes to set up before you can start 
your boxset binge.

Unfortunately, JBL has been forced to
compromise a lot in order to squeeze what it can 
into a speaker of this size and price point.
The Boost TV adds a crisp detail to high notes
and a real richness to dialogue, but with no
subwoofer its bass notes don’t provide a
satisfactory room-filling rumble. Its low-end
still lends TV shows and movies more depth than 
you’ll get from your standard television speakers, 
but makes it harder to recommend when
soundbar rival Razer Leviathan offers so much
for the same price.

A small soundbar best suited to those with tiny rooms to fill or tight budgets to work with,
Boost TV will deliver more depth and detail than expected but lacks bass.

JBL Boost TV
£169.99/$199.95

Verdict

The Boost TV supports Bluetooth, so
you can pair it with your iPhone, iPad or
MacBook, as well as your television.

With the Boost TV’s remote controller
you can toggle off the Bluetooth,
virtual surround sound and more.

The Boost TV will daisy-chain with 
other JBL Connect-enabled speakers 
to amplify your listening experience.

Key features Learn more
jbl.com

Available from
jbl.com
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Key features

getting a real bargain.

A triumphant move into the portable Bluetooth market from one of our favourite audio manufacturers. 
We can’t wait to see what Libratone has in store for us later this year.

Libratone One Click

Verdict

Libratone’s touch scroll wheel is an 
intuitive way to control playback, 
including altering volume levels

You can make the One Click as rugged 
and portable as you wish thanks to the 
myriad of detachable clips

The carry handle clips on effortlessly, 
meaning you won’t have any problem 
moving the One Click around
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Key features

Reviews

Artists may be drawn in by the Pixel’s pressure sensitivity, only to be stung by its odd controls. 
If you’re looking for pixel perfection, the Pixel is not for you.

Adonit Pixel Stylus

Verdict

Palm Rejection technology uses 
Bluetooth to distinguish between the 
pen and your hand – most of the time 

The shortcut buttons on the surface of 
the pen can be customised, but require 
a fair amount of force to press

Pressure sensitivity is controlled by 
stroke speed, not the pressure applied. 
Not every user will enjoy this change





90

Reviews

Accessories

Veho DS-1 Charging Dock 
for iPhone
£29.95/$39.95

www.amazon.co.uk
There’s one thing we like about this Veho DS1 Charging 

Dock – it comes with an attached charging cable. 
Certainly not be sniffed at. Sadly, that’s all the positives 

we can muster. With an iPhone 6 in situ there are massive 
balance issues that leave the stand constantly toppling 
backwards. Your iPhone isn’t particular secure either, 

because of the weak connection with the Lightning port. 
And because everything is terribly put together, when you 
get a notification, everything rattles badly and leaves you 
wondering if your iPhone is going to tip over. It’s not even 

that cheap, either. Avoid.

KitSound Malmo 
Bluetooth Sound System

£100.00/$TBA
www.amazon.co.uk

KitSound may well be the busiest audio manufacturer in 
the world, churning out affordable product after affordable 

product in a section of the market that it is slowly 
dominating. The KitSound Malmo does push your outlay 
to £100, but you do get a nice-looking, if slightly chunky, 
speaker in return. The brushed aluminium and black cloth 
combination is tasteful, while sound quality is admirable. 

There are two three-inch, 30-watt drivers to power things, 
which gives bass a punch. The high-end never reaches 

audiophile levels of quality, and it does crack at high 
volume. Still, there is a lot to like here.

Zepp Golf 2
£129.00/$149.99
www.zepp.com

There’s a whole world of accessories out 
there that can be paired with your iPhone 
to give you advanced feedback. Take the 
Zepp 2, for example, which sends instant 

evaluations of your golf swing to your phone, and then 
offers a smart coach system of training aids. Setup is 

painless – just clip the Zepp to your golf glove, pair with 
your iPhone and then take a few practice swings to 
calibrate. The Zepp will then measure critical swing 

analysis, including club speed, club plane, tempo and 
much more, all with the idea of showing you where 

you’re going wrong.
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Mujjo Carry-
On Folio

£99.56/$131.95
www.mujjo.com

Mujjo makes gorgeous-looking 
sleeves and cases using the finest 

materials available to man. And 
its new slipcase for the 12-inch 

MacBook is no different. It’s made 
from full-grain leather, which as 
a side note smells great, and 

wool felt on the inside provides 
exemplary protection. Even the 
zip and its leather loop scream 

sophistication. The carry handle is 
certainly a new way to transport 
your MacBook, and one we can 
see being used in an office like 

an iPad case. But for day-to-day 
commuting? We can’t see it being 

used in this way any time soon.  

Booq Cobra Pack 
£210.00/$295.00

www.booqbags.com
While it’s pretty tough for us to recommend 

anyone spending in excess of £200 on a 
bag, we can do our best to assure you that 

you’re getting the best of the best. Booq 
loves making black backpacks, and the high-performance 
silver zips create a lovely contrast. The outer shell is made 
from a ballistic nylon with water-repellent coating, while the 

inside includes a separate rigid-frame laptop section (it’ll 
happily house any MacBook), and plenty of room for 

accessories, paperwork, lunchboxes and anything else you 
can think of. It’s a high-quality purchase – even the 

shoulder strap has three adjustable points.
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In some ways, Alfred is like Spotlight. It is activated
with a hotkey and it searches for files, apps, the web
and so on, however it is much more powerful and
has many more features. It has a large number of
configuration options and can also be extended with
extra functions. The core features of Alfred are free
and it is a useful tool, but the best features can be
used only if you purchase a Powerpack licence.

Unlike most apps, which have a point-and-click
user interface, Alfred is driven by the keyboard.
Hotkeys are used to access some functions and
typed commands are used for most of the others.
These, along with the myriad of options, make Alfred
tough for newcomers to use fully, and unless you
spend time and effort learning how it works, you
won’t get much more out of it than Spotlight.

Master Alfred and you will be able to perform a lot
of useful functions without lifting a finger from the
keyboard. For example, you can launch Safari and

search a wide range of search engines and websites 
for information. There are commands for Google, 
Yahoo, IMDb and Amazon, and you can define your 
own. You can check spellings and get dictionary 
definitions, access anything copied to the clipboard 
in the last three months, find and launch apps, go to 
folders, images and more.

Snippets enable you to define shortcuts for words 
and phrases. Type the shortcut and Alfred expands 
it to the full text. A mini iTunes controller enables 
you to play music and you can access 1Password 
if you have it. Workflows is a powerful feature that 
is almost like programming, and you can create 
complex linked actions that save time and effort.

Alfred is like Marmite; some people will love it, 
others just won’t see the point. It relies on you being 
comfortable with typing commands and interacting 
with your Mac using only the keyboard, and takes a 
little time to fully master all that it has to offer.

A brilliant utility that adds lots of shortcuts and time-savers,
but it requires effort to learn and some parts are quite difficult to understand.

Alfred 3
£17/$23 (Powerpack licence)

Verdict

Use text snippets
Keywords can be defined, which

when used are replaced by strings
of characters, words or phrases

Multiple clipboards
Clipboard contents can be

remembered for up to three months.
Browse past items and select them

Get organised
Workflows makes Alfred

programmable and actions can be
linked to form time-saving chains

3 Key Features

“Perform a 
lot of useful 
functions 

without lifting a 
finger from the 

keyboard”

Requirements Learn more
www.alfredapp.com

Available from
www.alfredapp.com
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There are many reasons why Pixelmator
is among our favourite apps for Mac: it’s 
powerful, its user-friendly design looks 
great and it’s designed exclusively for 

Mac. In the latest release of the app, this means 
integration with Apple’s Core Image and Core 
Animation technologies. The question is, does all 
this fancy tech actually result in features that are that 
much better than before?

In some cases this is a firm, assured yes. 
Pixelmator has offered a Photos extension for its 
Distort tool for a while, but let’s be honest – did 
anyone really use it? Thankfully, version 3.5 brings 
with it a far more useful Retouch extension, which 
adds tools including Clone Stamp and Repair, 
as well as brushes for Light, Color, Soften and 
Sharpen. This means you can (finally) make 
adjustments to small parts of an image; the tools 
work perfectly, with useful animations that make 

edits easy to understand. Honestly, the app is 
almost worth buying for this alone.

The update also brings a couple of selection tool 
upgrades. The Quick Selection tool especially works 
well, and brushing over areas of your image to select 
it has been made quicker and even more accurate.

The Magnetic Selection tool is less successful, 
especially on blurry selections or images where 
colours blend slightly into each other around your 
shape. You can click to add anchors, but we found 
ourselves doing that more often than we would like. 
It certainly needs improvement, but this new system 
shows potential.

There’s a hell of a lot more to Pixelmator than 
these few tools, but this free update makes 
the app even more unmissable than before. If you 
have even a passing interest in more serious image 
editing, you owe it to yourself to invest in Pixelmator. 
Highly recommended.

This isn’t the most expansive update to Pixelmator that we’ve seen, 
but the updates are just another reason to invest in the best image editor for Mac.

Pixelmator 3.5
£22.99/$29.99

Verdict

Requirements Learn more
pixelmator.com

Available from
Mac App Store 

Magnetic Selection
Core Image technology powers the

Magnetic Selection tool to make
grabbing sections quick and easy

Quick Selection
Use this tool to simply draw over

an area to select a section
of your image

Photos extension
The biggest addition is the Retouch 
extension for the Photos app, which 

adds a great deal of extra power

3 Key Features

“The tools 
work perfectly, 

with useful 
animations 
that make 

edits easy to 
understand”
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Reviews

Styling made easy
RapidWeaver has a whole host of
built-in themes, and more can be
bought from the community store

Health Check
This useful feature points out

common SEO errors and helps you
quickly fix them

Extend your website
The store opens up a world of

add-ons that cover everything from
eCommerce to interactive galleries

3 Key Features

Building website design software that keeps up with
the ever-changing internet isn’t easy. Apple itself 
seemed to admit this when it ceased development 
of iWeb back in 2011. What’s more, with so many 
web-based tools designed to help you create 
beautiful websites, is a Mac app even necessary? 
Realmac Software seems to think so and with 
RapidWeaver 7, it looks like it’s got it right.

RapidWeaver has been on the Mac for over 12 
years. Despite this, it’s very much made for the 
modern web. There are plenty of built-in, responsive 
themes to choose from and the app’s preview 
mechanism even scales down to an iPhone-sized 
screen so you can be sure everything looks great on 
the go. RapidWeaver 7 also minifies any JavaScript 
and CSS files that your project includes to ensure 
your website loads fast.

If you’re an absolute beginner, RapidWeaver’s 
plethora of options and expansive interface will take 

some getting used to, but the app’s design feels as 
familiar as Apple’s own suite of apps, so you’ll soon 
find your way around. Some existing knowledge 
is required to get your website online: for starters, 
you’ll need to have your own website hosting, as 
well as your host’s FTP details in order to publish 
your site using RapidWeaver’s built-in FTP client.

For previous RapidWeaver users, iWeb 
aficionados and anyone with a little experience, 
RapidWeaver really does deliver, with enough 
customisation options and granular control to please 
all but the pickiest of web developers. Taking an 
existing theme and making it your own is easy, 
thanks to a number of custom code input options. 
The SEO Health Check feature provides a dynamic 
checklist to ensure sites are search-engine friendly, 
too. For anyone serious about creating websites 
on their Mac, RapidWeaver not only picks up from 
where iWeb left off, but builds on it with aplomb.

RapidWeaver might seem a little intimidating to the absolute beginner, 
but it’s a sound investment for anyone serious about building websites on their Mac.

RapidWeaver 7
£75/$99

Verdict

Requirements
OS X 10.11

Learn more
www.realmacsoftware.com

Available from
www.realmacsoftware.com

“The app’s 
preview 

mechanism 
even scales 
down to an 

iPhone-sized 
screen”
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Time Machine is fine as far as it goes, but there are
alternative back-up apps that provide more features 
and flexibility. Data Backup Pro, for example, 
has four types of backup, making the app more 
complicated than the ultra-simple Time Machine – 
but its extra choices make it far more useful.

A simple copy backup can be performed with files 
in the source, such as your Home folder, copied to 
a destination like an external drive. A synchronise 
option keeps the source and destination identical, 
adding or deleting files as necessary. A versioned 
backup is a traditional one, and files are backed up 
with optional encryption and compression. Previous 
versions of files are stored and you can choose how 
many versions to keep. Although the first copy is 
slow, subsequent copies are fast because it only 
includes files that have changed. An additional clone 
option makes an exact copy of the Mac’s disk on an 
external drive. This external disk is then bootable, 

useful if your Mac’s disk fails. On the down side, 
there are no encryption or compression options, 
so you can’t choose between speed and space or 
security. There is an option to back up to DVDs, 
but you wouldn’t want to use it for anything other 
than small folders. 

With Data Backup Pro you can also schedule 
your backups, making it more flexible than Time 
Machine. During a backup a dashboard provides 
geeky information, like a live chart showing the files 
or megabytes per second written, the files selected, 
copied and being copied. Restoring files from 
versioned backups could be easier, but simple and 
synced backups and clones are fine.

If you need more features than Time Machine 
provides, Data Backup Pro is worth considering. 
With it’s four back-up options and additional 
features that include scheduling, Data Backup Pro is 
a far more flexible alternative.

Data Backup Pro has more features than Time Machine, predefined back-up sets, 
cloning and syncing. It’s good, but there’s a price rise coming soon.

Data Backup Pro
£36/$49.99 (introductory offer)

Verdict

Requirements Learn more
www.prosofteng.com

Available from
www.prosofteng.com

Drag and drop
The source and the destination for
backups are set by dragging and

dropping folders from Finder

Schedule options
Backups can be scheduled to
occur every minute, on certain

days or on a particular date

Restore files
Select a backup in the destinations 
and you can browse the folders and 

files you wish to restore

3 Key Features

“An additional 
clone option 
makes an 
exact copy 

of the 
Mac’s disks”
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Cinema fans will immediately envisage a checklist
of vital characteristics whenever ‘film noir’ is used to
describe a movie. Morally flexible private detectives,
breathlessly beautiful dames in distress, shady clubs
filled with cigarette smoke and slow-burning jazz…
you get the picture. Calvino Noir is a game that
embraces all these genre hallmarks and attempts
to deliver a stylish homage across iOS and indeed
Mac. The gameplay can be best summed up as
a stealth puzzler, built around a side-scrolling
perspective for guiding each of the three characters
around Thirties architecture. Central protagonist
Wilt is the archetypal ‘scrambler’, a mercenary for
hire who unwittingly descends into the criminal
underworld after accepting a job from the
mysterious Siska. Although the pastiche narrative
begins with controlling just Wilt, the story quickly
introduces the abilities of mechanical wizard Arno
and Siska’s own lock-picking prowess.

Switching between each, the fundamental goal 
is to click-move successfully past guards without 
being detected. There’s not much margin for error 
here and the typical evasion tactic tends to be 
waiting for a chance to dash or opening doors to 
scout new, less-protected areas. In order to activate 
each investigative checkpoint however, the game 
demands each character be guided to the same 
place one at a time. While this brings a certain 
amount of inventiveness and strategy, it also makes 
Calvino Noir clunky and repetitive with each of 
the increasingly large levels effectively traversed in 
triplicate. However, all is not lost. The game looks 
great despite featuring an appropriately dark, drab 
and dank aesthetic devoid of most colours beyond 
grey. An art style drenched in noir lighting alongside 
an atmospheric music score is worth the admission 
alone, while Calvino Noir still deserves applause for 
independent originality and admirable authenticity.

Central character Wilt might love a good Mac but Calvino Noir
equally frustrates and delights with clunky, yet stylish, stealth.

Calvino Noir
£4.99/$6.99

Verdict

“Why you dirty rat”, quite literally –
Wilt spots some local wildlife while

exploring the sewers

Wilt is able to call upon the help of
Arno and Siska in trying to

crack the case

Skilful use of your trusty
torch exposes cash pickups

scattered throughout

The plot is packed with intrigue
and subterfuge, underpinned by a

well-scripted narrative

“Calvino Noir 
still deserves 
applause for 
independent 
originality and 

admirable 
authenticity”

We used

Available from
Mac App Store
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